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Advance User Guide
Making Requests

Making a Request

The following procedure shows you the general steps to follow to make a simple chart, 
report, or data format request. 

For an interactive step by step demonstration, see the Advance 4 tutorial, select 
Advance Tutorial from the Help menu. 

To make a request:

1 Select the category of series – see Data categories, page 2
2 Select the series – see Selecting a series, page 3 
3 Select the type of request – see Selecting types of request, page 9 
4 Select a chart, report, or data format from the list displayed
5 Refine your request 

• Select the display period, see Display period adjustments, page 11 
• Select the datatype, see Datatype adjustments, page 13 
• Select the currency, see Currency adjustments, page 14 
• Select the settings, see Using settings, page 127

6 Run your request
• Run Now – see Making your request, page 10 
• Run later – use Schedule Night Shift, see Schedule night shift, page 98 
• Save your request details – use Favourite, see favourites, page 97

7 View your results, you can 
• Print, see Printing, page 15
• Export, see Exporting, page 19
• Copy, see Copying, page 16
• Transfer, see Transferring, page 17
• Customise your charts and reports, see Customising your charts and reports, 

page 59 
• Use Advance for Office, see the Advance for Office user guides for more 

details.
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Selecting a data category

Datastream series are stored in a database and are accessed using Datastream 
Navigator. The series are grouped into 18 data categories, which are selected from the 
Category drop down list. Selecting a data category gives you access to all the series 
within that category.

To select a data category:

1 Click the Category drop down box.
2 Scroll through the categories listed and select the one you want.

Click to list the categories and 
select one from the list.

� Equities
� Equity indices
� User created indices
� Constituent lists
� Local lists
� Unit trusts
� Investment trusts
� Bond and convertibles
� Bond indices
� Warrants
� Economics
� Economic reports/charts
� Exchange rates
� Interest rates
� Futures
� Options
� Commodities
� User created time series

You can select:
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Selecting a Series

Use Datastream Navigator to find and select the series you want, or if you know the 
exact Datastream mnemonic or code, or SEDOL, ISIN, or other Datastream supported 
code, check the Expert entry check box and type the mnemonic or code in the Series 
field to select your series. 

Expert entry

Use expert entry if you know the exact Datastream mnemonic or code, or SEDOL, 
ISIN, expression, expression code, or other Datastream supported code for the series 
you want.

To select a series using expert entry: 

1 Check the Expert entry check box.
2 Type the exact mnemonic or code in the Series field. 

The series chosen is displayed in the Series & Datatype selected box.

Recent Series

You can use the Recent series drop down box to select from the last 12 series used. 

Note:
You can also type the first few characters of the name in the series field and press ENTER. The    
Navigator Screen is displayed with series matching your search criteria.

Click the Series 
navigation button 
to display the  
Datastream 
navigator.

Click the  Recent 
series button to 
display a list of 
recent series.

Expert entry:
Check the Expert 
entry box and 
type the exact 
mnemonic or code 
directly in the 
Series field.
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Using Navigator

Datastream navigator gives you the options to use quick search, power search, and 
drill down to find your series.

Quick search

Quick search is the most basic search. Use this to search by the name, mnemonic, or 
Datastream code of the series you are looking for.

To find and select a series using quick search:

1 Click the Series navigation button.
The Datastream navigator is displayed.

2 Select the quick search button.
3 Select name, DS Mnemonic, DS Code,SEDOL, ISIN, Local code, or IBES Ticker 

from the find drop down box.
4 Select starts with, or contains from the that drop down box.
5 Type the first few characters of the name, mnemonic, or code in the Search field.
6 Click the Search button.

The series matching your search are displayed. 
7 Select the series that you want from the list displayed.

The series chosen is displayed in the Series & Datatype selected box. 

If the series you are looking for is not displayed, edit the text in the Search field and 
click the Search button to repeat the search. 
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Power search

Power search helps you speed up the search for your series by using search criteria. 
Use power search to create your own search criteria. 

To find and select a series using power search:

1 Click the Series navigation button.
The Datastream navigator is displayed. 

2 Click the power search button.
3 Select the search criteria from the find drop down box.

To add a search criteria for: 

Select starts with or contains from the that drop down box.
Type the search criteria, eg coca, in the field and click the add to criteria button.

To add a search criteria for:

Select a value from the list displayed to add it to your search criteria
OR
Select starts with, or contains from the find market/currency/etc that drop down 
box.

Type the search criteria, eg united, in the search field and click the search button.
The options matching your criteria are listed.

Either, select one of the criteria from the list displayed
OR
Edit the criteria in the field and search again.

4 Click the show criteria button to display your criteria.
5 You can add or delete criteria in the list. 
6 When the list is complete, Click the search button to display the series meeting 

your criteria.

• Name • Base date
• DS mnemonic • Exercise date
• DS code • Management mnemonic
• SEDOL

• Market • Unit • Call/put
• Currency • Type • From curr
• Source • Key indicator • To curr
• Class • Adjustment • Country
• Frequency • Borrower • Exchange
• Primary Quote • Adjusted prices
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Drill down

For equity and economic series, you can use drill down to search for your series. This 
enables you to search the database hierarchically by countries and sectors.

To select a series using drill down:

1 Click the Series navigation button.
The Datastream navigator is displayed. 

2 Click the drill down button.
The Filters dialog is displayed.

3 Select a folder in the left pane, its contents are displayed in the right pane. You 
can keep drilling down until no further selections can be made in the left-hand 
window.
The path is displayed at the top of the right pane.

4 Select the series you want and click OK.
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Using the Datastream Help Browser

For the data categories: indices, constituents, bond indices, interest and exchange 
rates, economics, options, and futures, you can use the Datastream help browser to 
display Datastream help on mnemonics and weekly economic series. The browser 
enables you to navigate through Datastream help pages to display and select the 
required mnemonic for a request.

You can use the Datastream Help Browser when the help browse button appears 
on the Navigator screen.

Click the help browse button to display the Datastream help browser screen.

To select a 
topic, double 
click on the 
option number, 
or enter the 
option number 
in the Go To 
field and click 
the Go To 
button.

Use the navigation buttons to 
move forward or back though 
the help pages.

When you have selected the mnemonic, 
click Finish to paste the mnemonic into 
Advance.
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To use the Datastream help browser:

1 Click the help browse button.
2 Double-click on the option number

OR
Type the option number in the Go To field and click the Go To button.

3 The Navigation buttons, Home, Back, and Next help you move forward or back 
though the help pages.

4 Select the mnemonic that you want to use.
5 Click Finish to paste the mnemonic into Advance.

If you chose an individual Datastream mnemonic, the series is displayed in the series 
display area. If you chose a group mnemonic, for example GOLDS, all series with 
mnemonics starting with GOLDS are displayed. 
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Selecting types of request

Advance gives you access to a wide range of reports, charts, summaries, overviews, 
and comparison requests. 

Over 100 Datastream reports, charts, and data formats are stored in Advance’s 
database. You can access these by selecting a report/chart tab on the Request 
screen.

You can select request types:

Report/chart type 
tabs

Overviews - You can request Datastream company, commodity, warrant, trust, and 
bond performance overviews and a range of fixed format I/B/E/S forecast overviews.

Charts - You can request any of the standard Datastream graphics, including Line, 
Moving Average, Stochastics, High-Low-Close, Candlesticks, and Bollinger Bands.

Reports - You can select from a range of pre-formatted report types including Profit 
& Loss, Dividend & Earnings, Key Accounts Ratio, and Company Profiles.

Data formats - You can download time series, static, and company accounts data, 
which you can export or transfer to your spreadsheet.

Summaries - These are used for data requests for lists of series. For example, 
performance, geographical, and industrial summaries for a Datastream constituent 
list. Values for all constituents are displayed in one summary report, chart, or data 
format.
Datastream Mnemonic search – Two tools are available to search the Datastream 
database for company mnemonics. The searches can be for ‘live’ or ‘dead’ stocks.

Comparisons - You can request information on multiple series, enabling you to 
create comparisons across different data category types, and use flexible charts to 
create multiple chart requests. For example, you can compare an equity with an 
index such as the CAC40 and with an economic series such as the RPI.
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Making your request

Once you have selected the criteria for your request and made your date, datatype, 
and currency adjustments, you can make your request:

RunNow: Request the report, chart, or data straight away. 

This connects you to Datastream and displays the result. You 
can change the request criteria and click the button again, or 
save the request for future use.

Add new request: Add the request to the open Project to refresh later. 

This does not connect you to Datastream, but stores the 
request in the open Project. This enables you to work off line 
and send all your requests at a time of your choice

See Using Projects, page 92
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Refining your request

Dates 

Each data category has a default date range. You can choose your own from four 
display period options:
� Fixed start and end dates - a fixed period, for example the whole of last year.

� Relative start and end dates - a fixed period relative to today’s date.

� Datastream base date - a period starting with the date of the earliest data 
available on the database for a series.

� Today - a period ending with the latest available price or value. Intra-day prices 
are available for many markets. To receive the latest intra-day price or value, you 
must subscribe to the intra-day service.

Advance enables you to combine these start and end date options.

To select a date period:

1 Click the Date button.
The Configure Dates dialog is displayed.

Date button

Relative dates
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2 Select the date options:

• Fixed option 
To specify a fixed period in the past as the start of your display period. 
Use the spin buttons to select a date or type a date in the date field.
��Calendar button (next to the Fixed display field) – to select a fixed (start 

or end) date from an interactive calendar.
��Show as Year check box – to specify a yearly period, for example, if you 

are interested in viewing 5 year's worth of data. This converts the date 
into a whole year.

• Relative option
To set a display period relative to a fixed end date, a relative end date, or 
‘today’. 
Use the spin buttons and pick list to select the relative period.
��Before Today option - to specify both start and end periods before today
��After Today option – to specify both start and end periods after today, for 

series that are projected into the future.
��Year Ends – to request a number of year ends for company accounts 

reports and data.
• Datastream Base Date option

To set the display date from the earliest data held
• Today option

To request the latest (intraday) prices or values available on Datastream.To 
receive the latest intra-day price or value, you must subscribe to the intra-day 
service.

3 Click OK.

If the majority of your requests use a fixed display period, for example, the past 5 
years, you can use the Display Date Options from the Tools>Options menu to 
display set display periods on the Request screen.

Click these options to select default relative display periods, relative to today’s latest 
available price. 

They can be turned on/off via the Tools>Options menu. See Advance Reference 
Guide, Advance Options, page 15
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Datatypes 

The datatype defines the type of data. For example, the default datatype for equities is 
Price (Adjusted).

For some data categories and report/chart types, you can select the datatype. For 
example, for an Equity line chart request you can change from the default Price 
(Adjusted) datatype to Price - Opening.
Datatypes are grouped by their type and source. For example, Datastream time series, 
static, company accounts, I/B/E/S datatypes, MSCI datatypes, and Worldscope data 
items.

When the Datatype field is enabled, use Datastream Navigator to find and select the 
datatype you want, or if you know the exact mnemonic, you can use the Expert entry 
tab to select your datatype. 

Using navigator

Datastream navigator enables you to search for the datatype you want by name or 
mnemonic, and by type and source. You can select datatypes from a number of data 
sources. For equities, you can choose from:
� Datastream time series and static datatypes

� Datastream account items

� I/B/E/S datatypes
� MSCI datatypes

� Worldscope data items

To select a datatype:

1 Click the Datatypes navigation button.
The Datastream navigator is displayed.

2 Select name or mnemonic from the find drop down box.
3 Select starts with or contains from the that drop down box.
4 Select the type of datatype, static or time series from the type drop down box.
5 Select the source from the group drop down box.
6 Select a datatype from the list displayed.

The datatype selected is displayed in the Series & Datatype Selected box.

Definitions 

Click the Definition button to display the definitions help. Descriptions on the use and 
derivations of the data is available.
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Currency 

You can select which currency you want to display your results in.

 

Click the currency dropdown box and select a currency from the list displayed.

Note:
The parameters you can change are dependent upon the data category and chart, report or data 
format chosen. For example, you can change the date, data type and currency for an Equity - 
Line Chart request but only the date for a Constituent - Bar Chart request.

Currency drop down box
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Using your results

All the reports, charts, and data formats you request from Datastream are displayed 
within Advance and are automatically added to the current open Project. You can also:
� Print your charts and selected pages of reports to any Windows printer.

� Copy reports, charts, and data formats to the Windows clipboard for pasting into 
Windows compatible applications.

� Export reports, charts, and data in a variety of formats for use with other 
applications such as word processors.

� Transfer data to Microsoft Excel. Data downloaded from Datastream can be 
transferred to your spreadsheet for regular updating.

� Transfer charts to Microsoft Office applications, Excel, Word, and PowerPoint. 
You can transfer your chart requests directly into these applications as embedded, 
dynamic objects. Once embedded, the requests can be refreshed within the 
applications.

Printing reports, chart and data

You can print any displayed report, chart, or data format to the default Windows printer. 

To print your report, chart, or data format:

� Select Print from the File menu
OR click the Print Current Request button to print the request displayed. 

To change the printer or printer settings, select Print Setup for either Report or Chart 
from the File menu.

You can print requests after they have been refreshed with Schedule Night Shift. See 
Scheduling Projects and Project Settings, page 99 for details on how to do this. If you 
schedule a project to be refreshed and printed via Scheduled Night Shift, all requests 
in the Project are printed.
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Copying reports, charts, and data

You can copy the displayed report, chart, or data format to the clipboard, and paste it 
into other Windows applications.

Copying a report:

1 Select the area of the currently displayed report to be copied; this can be:
• A range of cells - click your left mouse button and drag the cursor over the 

display area to define the cell area to be copied.
• The whole report (default) - the whole report is selected automatically when it 

is displayed.
2 Select Copy from the Edit menu.

Note:
The report text will be held in the clipboard in text format with TAB formatting, but without font and 
text formatting.

Copying a chart:

� Select Copy from the Edit menu.

Note:
The chart will be held in the clipboard as a Windows Meta File.

Copying data:

1 Select the area of the currently displayed data format to be copied, this can be:
• A range of cells - click your left mouse button and drag the cursor over the 

displayed spreadsheet to define the cell area to be copied to the clipboard.
• All the data (default) - the whole data request is selected automatically when it 

is displayed.
2 Select Copy from the Edit menu.

Note:
The data selected will be held in the clipboard in text format with TAB delimiting for direct pasting 
into a spreadsheet or word processor.
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Transferring data to Excel

You can make data requests. Advance can retrieve data from the Datastream host 
using Datastream’s dedicated API (DSAPI). This data can be transferred directly into 
Microsoft Excel. You can request:

� Time series data - downloaded values from a single series between two dates at a 
specified frequency. For several time series, use the Time series data option on 
the Comparison tab.

� Static data - downloaded values for a number of series at a particular date.

� Company accounts data - downloaded company accounts data for one or more 
companies at a specified frequency.

When you request one of these data requests, the data is displayed in the Advance 
display area in spreadsheet format.

To transfer data to Excel:

1 Select the Data for a single series tab.
2 Select Time series, Static, or Company accounts data.
3 Select the parameters for your data request.
4 Click Run Now.

The results are displayed.
5 Select Transfer>Excel from the Tools menu or click the Transfer Result to 

Spreadsheet button. 
The Transfer Settings dialog is displayed.

6 Select the Transfer options:
• Data from viewport – without creating a dynamic link 

OR
• As refreshable object – transfer the data request as an embedded, dynamic 

object. 
7 If Excel is open, you can transfer the data request to the current open sheet 

OR
Advance can automatically open Excel creating a new sheet by default. 

8 You can insert the data at a specific cell position by indicating the row and column 
position
OR
if you are already running Excel, you can insert the data at the current active cell. 
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9 Click OK. 
The data is transferred to your Excel spreadsheet.

Note:
If you have chosen to transfer the data request as a refreshable object, the underlying reference 
codes for the data request are copied across to your spreadsheet as a link.You can refresh the 
data request in Excel at anytime by right-clicking on the mouse and selecting the Refresh option. 

Transferring requests to MS Office 

If you use Office 2000, you can use Advance for Office, AFO. You can transfer data 
requests into Excel, and charts into Excel, Word, and PowerPoint as refreshable 
objects. 

You can refresh embedded requests in Excel, Word, and PowerPoint, without opening 
Advance, by right-clicking the mouse and choosing either Refresh or Autorefresh. 
� Refresh - this enables you to refresh your requests on an ad hoc basis.

� Autorefresh - this enables you to refresh your requests every time you open your 
document, spreadsheet, or presentation.

See the Advance for Office User Guides  for more details.

To transfer a chart request to MS Office:

1 Select the parameters for the request.
2 Run the chart or data request.
3 Select Transfer to Excel, (Word, PowerPoint) from the Tools menu, or from the 

right click menu.
Excel (Word, PowerPoint) is opened with a new worksheet, (document, slide). 
Your chart is displayed.

4 You can display the chart:
• as a single element 

OR
• as an Office picture – select Display as Office picture from the right click 

menu.
This gives you the Office format picture options.

To display the chart as transparent:

� De-select Display original background from the right click menu over the 
Refresh button.
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Exporting charts, reports, and data

You can export the displayed report, chart, or data in a format suitable for use with 
other software packages. The data formats available for reports, charts and data are 
given below.

1 Select Export from the Tools menu. The Export Viewport As dialog is 
displayed.

2 Select the export details:
• Type an export name.
• A drive or server destination.
• An export format

3 Click OK.

You can export requests after they have been refreshed with Schedule Night Shift. 
See Scheduling Projects and Project Settings, page 99 for details on how to do this. If 
you schedule a project to be refreshed and exported via Schedule Night Shift, all 
requests in the Project will be exported in one go.

Formats for 
Reports and Data

Description

 *.XLS suitable for import to Excel 4.0 and Excel 5.0

 *.PRN undelimited text format

 *.TXT TAB separated format

 *.CSV comma separated format

 *.HTM HTML format for Internet and Intranet sites

Formats for Charts

 *.WMF Windows Meta File format

 *.CGM Computer Graphics Metafile

 *.EPS Encapsulated Postscript

*.GIF Graphics interchange file

*.PCX Zsoft PC Paintbrush File
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4 Click OK. 
The data is transferred to your Excel spreadsheet.

Note:
If you have chosen to transfer the data request as a refreshable object, the underlying reference 
codes for the data request are copied across to your spreadsheet as a link.You can refresh the 
data request in Excel at anytime by right-clicking on the mouse and selecting the Refresh option. 
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Using Local Lists

What are Local Lists?

Local Lists are a good to make report, chart, and data format requests for groups of 
series that you use frequently. Instead of making an individual requests, you can make 
one request to get results on all the series you are interested in. You can use the 
Request or Project screens to refresh your lists in Advance.

A Local List could be used to create a report on the series that make up a portfolio or 
the series that belong to a sector of interest. The following list contains 10 top equities 
by market value in Brazil:

All Local Lists have the same constituent parts:
� List title - this is the main list record, which is identified by its title

� Individual series - these are the individual series that make up the list

Local Lists, as the name suggests, are held locally on your PC. You decide what lists 
you need and what contents they should have.

List Title Individual series

Brazilian Top Ten Petrobras ON

Brasperola ON

Petrobas PN

Telebr RCTB RPN

Telemig PND

Electrobras ON

Telebr RCTB RON

Vale R Doce ON EJ

Ambev PN

Itubanco ON
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Types of List

There are three types of list in Advance:

� Local List - this is a list created by you using Advance’s List Wizard and stored 
on your PC. These lists can be uploaded and stored on Datastream.

� Datastream Constituent List - this is an industry standard or Datastream market 
and sector constituent list held and maintained on Datastream. These lists can be 
downloaded from Datastream at any time using Advance’s List Wizard, and 
maintained locally.

� User List (L# list) - these are either, lists created using DSWindows or Local Lists 
that have been uploaded onto Datastream. These lists can be downloaded from 
Datastream at any time using Advance’s List Wizard, and maintained locally.

Types of List requests

Typically, when you create a Local List, the list will contain a series of one type, for 
example, a list of warrants or a list of commodities. You can issue a request for a Local 
List for any report, chart or data format, however, the type of series in your Local List 
determines which reports, charts, and data formats you can select from the report/ 
chart tabs. For example:

Using local lists with flexible chart

You can make a flexible chart request using a list of series. This produces a chart for 
each series in the list. You can also produce multi-line charts. Add the list more than 
once, and select the multiple line per chart option. You can plot up to 8 series per 
chart, ie, add the list 8 times. See Making a flexible chart request for a list, page 79.

when you select... you will get...

Summaries A consolidated output for all the series in the Local List

Overviews, Reports, 
Charts, Data, 
Comparisons

A separate report, chart or data format for each series 
in the Local List
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Making a Local List Request

Select Local Lists from the Category drop down box. Two windows are displayed:

To make a Local List request:

1 Select Local Lists from the Category drop down box.
2 Select a Local List from the list displayed.
3 Select All in the series window to include all series in the request, or select a 

single series.
4 Select the type of request, a report, chart, or data format.
5 Select the display period, datatype, and currency display, if appropriate.
6 Click Run Now.

Note: 
You can use Sort from the right click menu to sort the list of local lists displayed by alphabet or 
by date.  

This is a list of the Local Lists 
held on Advance. This can include 
your own lists, or lists 
downloaded from Datastream.

This displays the contents of the selected list. To 
issue a list request, you can click on All to include all 
constituents in the request or select an individual 
series.
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Viewing a Local List

You can view the results of a Local List request on both the Request and Project 
screens. 

To view a Local List request on the Request screen:

1 Use the Browse bar drop down list to view the individual elements that make up 
your Local List request, that is the list title and individual series requests. 
You can also use the move to next and previous request arrows to scroll through 
them.

2 Select the list title, or individual series to view the details of the request.

To view a Local List request on the Project screen:

1 Select the Project tab.
2 Check the Keep List Together box to list the series requests indented under the 

main list title.
3 Select the list title or individual series to view the request results 

On the Project screen, you can view all the Local List requests that belong to a Project. 

Refreshing a Local List Request

You can refresh existing Local List requests on both the Request and Project screens. 

To refresh a Local List request on the Request screen:

1 Select the request to refresh in the Browse bar. 
2 Click Run Now.

To refresh a Local List request on the Project screen:

1 Select the Project tab.
2 Select the request to refresh, either, a whole list request, or an individual series 

request. 
3 Double-click the button to the left of the selected request.
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Deleting a Local List request

You can delete existing Local List requests on both the Request and Project screens.

To delete a Local List request on the Request screen:

1 Select the Local List request to delete.
2 Press the DELETE key.

OR
select Delete from the right click menu. 

3 You are prompted to confirm deletion.

To delete a Local List request on the Project screen:

1 Select the Project tab.
2 Select the Local List request to delete, either, a whole Local List request, or an 

individual series request. 
3 Click the Delete Current Request button on the toolbar.

When you delete a list title, you are prompted to confirm that all series requests in the 
list are to be deleted as well.

Note:
The lists that are accessed from the Local Lists category and the lists that are viewed and 
refreshed from the Project screen are two separate entities. The lists under the Local Lists 
tcategory are the actual lists from which requests are generated. The Project screen displays only 
the results of a list request.
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The List Wizard

This wizard enables you to:

� Create a new list
� Edit an existing list 

� Download a constituent list from Datastream

� Download a user list from Datastream
� Download a UCI list from Datastream

� Download Datastream bond list

� Merge Local Lists

Click the List Wizard button to 
display the List Wizard.
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Creating a Local List

To create a Local List:

1 Select Local List from the Category drop down box.
2 Click the List Wizard button, or select List Wizard from the Tools menu.

The List Wizard dialog is displayed.
3 Select Create a new list and click the Next button.

4 Select the data category from the Data Category drop down box.
5 Click the Series navigation button to use Datastream navigator to select your 

series, see Selecting a Series, page 3
OR
If you know the exact mnemonic, check the Expert entry check box, type the 
mnemonic and click the Add button.

Series Navigation button

Data Category drop down box

Series selected for your list

List title
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.

6 To remove series from the list, select the series and click the Remove button.
7 Use the Sort List button to sort the list alphabetically

OR
the Raise and Lower buttons to move the selected item up and down in the list.

8 Click the Next button, when your list is complete. 
9 Type the list name (XXX.LLT) and description in the fields displayed.
10 Select a save option:

Save as local list. Saves the list on your local drive.
Save as local list and Upload to datastream as a User list. Saves the list to the 
Datastream database, where it is stored as an L# list.
Save as local list and Upload to datastream as a UCI list. Saves the list to the 
Datastream database as a user created index list, where it is stored as an X# list.

11 Click the Finish button.

When you have saved your list, the list is held locally on Advance and is available for 
immediate use.

Note:
You can also create an index list from a local list in the List Wizard. When you have created or 
edited a local list, you can select the option to save it as a local list and upload it to Datastream 
as an index list. 

 Remove button Lower button

 Raise button Sort List button
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Editing a Local List

To edit a Local List:

1 Select Local List from the Category drop down list.
2 Select the list you want to edit from the lists displayed.
3 Click the List Wizard button, or select List Wizard from the Tools menu.

The List Wizard dialog is displayed. 
4 Select Edit an existing list and click the Next button.
5 5 To add series to the list, click the Series Navigator button to use Datastream 

Navigator to select your series, see  Selecting a Series, page 3 
OR
If you know the exact mnemonic, check the Expert Entry check box, type the 
mnemonic and click the Add button.

6 To remove series from the list, select the series and click the Remove button.
7 Use the Sort List button to sort the list alphabetically

OR the Raise and Lower buttons to move the selected item up and down in the 
list.

8 When you have finished your editing, click the Next button.
9 Edit the list name (XXX.LLT) and description, if required.
10 Select a save option:

Save as local list. Saves the list on your local drive.
Save as local list and Upload to datastream as a User list. Saves the list to the 
Datastream database, where it is stored as an L# list.
Save as local list and Upload to datastream as a UCI list. Saves the list to the 
Datastream database as a user created index list, where it is stored as an X# list.

11 Click the Finish button.

When you have saved your list, the list is held locally on Advance and is available for 
immediate use.

If a Local List is edited in Advance and the Upload button is selected in the lists 
wizard, the same L# list number is used, overwriting the original list. Similarly, in Equity 
Search where a list is generated from a search request, uploaded and then refined, a 
subsequent upload to Datastream will use the same L# number. The L# number is also 
displayed on the status bar. Local lists with series from several data categories, for 
example, Equities and Unit Trusts, can now be created in the list wizard.
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Getting names from a local list of codes created in AFO 

You can create a list from a code list in AFO excel and save it as a local list. You can 
then open this list in Advance and get the names for the codes. For example a list of 
ISIN codes.

To get names:

1 Select local lists from the Category drop down box.
2 Select the list containing codes from the list displayed.
3 Select Get Names from the right click menu.
4 The names are displayed against the codes.
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Downloading Datastream Constituent Lists

You can use the List Wizard to download Datastream and industry standard 
constituent lists. Datastream includes over 3,500 constituent lists, which include 
market and sector constituents, for all leading markets.

To download constituent lists:

1 Select Local List from the Category drop down box.
2 Click the List Wizard button, or select List Wizard from the Tools menu.

The List Wizard dialog is displayed.
3 Select Download a constituent list and click the Next button.
4 Click the Series Navigator button to use Datastream Navigator to select your 

series, see Selecting a Series, page 3 OR
If you know the exact mnemonic, check the Expert Entry check box, type the 
mnemonic and click the Add button.

5 Select the list you want to download, and click the Next button.
6 Click the Finish button to download the selected list.

Downloading User Created Lists
To download a user created list:

1 Select Local List from the Category drop down box.
2 Click the List Wizard button, or select List Wizard from the Tools menu.

The List Wizard dialog is displayed.
3 Select Download a user created list and click the Next button.

The lists stored on Datastream are displayed. 
4 Select the list you want to download.
5 Click the Next button.
6 Click the Finish button to download the selected list.

Advance lets you download user created lists from Datastream for storage and use 
with Advance. These lists include lists created with DS Windows programs or lists 
created by you with Advance that have been uploaded onto Datastream.
The list will be available immediately from the Local Lists tab for all your report, chart, 
and data format requests.

Note:
Downloaded lists are a one-off copy of the list held on Datastream. They are not updated when 
you change the list on Datastream.
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Downloading User Created Index lists
To download a user created index list:

1 Select Local List from the Category drop down box.
2 Click the List Wizard button, or select List Wizard from the Tools menu.

The List Wizard dialog is displayed.
3 Select Download a user created index list and click the Next button.

The lists stored on Datastream are displayed. 
4 Select the list you want to download.
5 Click the Next button.
6 Click the Finish button to download the selected list.

Advance lets you download user created index lists from Datastream for storage and 
use with Advance. These lists include lists created with DS Windows programs or lists 
created by you with Advance that have been uploaded onto Datastream.

The list will be available immediately from the Local Lists tab for all your report, chart, 
and data format requests.

See Using indices, page 34.

Note:
Downloaded lists are a one-off copy of the list held on Datastream. They are not updated when 
you change the list on Datastream.

Downloading Datastream Bond Lists

To download a bond list:

1 Select Local List from the Category drop down box.
2 Click the List Wizard button, or select Lists Wizard from the Tools menu.

The List Wizard dialog is displayed.
3 Select Download a Datastream bond list and click the Next button.

Options are displayed.
4 Use the options to create the bond list you want to download.
5 Click the Next button.
6 Type a description and list name in the Description and Name fields, if the 

defaults are not suitable.
7 Click the Finish button to download the selected list.
Datastream Advance version 4.0, Issue 1 32



Advance User Guide
Advance lets you download bond lists from Datastream for storage and use with 
Advance. The list will be available immediately from the Local Lists tab for all your 
report, chart, and data format requests.

Merging two or more lists into a single list

You can merge two or more lists to form a new list.

To merge lists:

1 Select Local List from the Category drop down box.
2 Select List Wizard from the Tools menu.

The List Wizard dialog is displayed.
3 Select Merge Local Lists and click the Next button.

The Merge Local Lists dialog is displayed.
4 Select the data category from the Category drop down box.
5 Select the lists you want to merge and click the right arrow button.

To select more than one list, hold down the CNTL key and select the lists you want.
6 Type the description and name of the new list in the Description and Name fields.
7 Click the Merge Lists button. 
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User created indices

The UCI Manager enables you to create and maintain your own indices. Each index is 
based on a list of constituent data series, which you specify as the first step of the 
index creation process. Once created, the index can be automatically maintained for 
you, with new values calculated on a daily basis. User created indices are valuable 
additions to your suite of research and analysis tools, enabling you to track the 
performance of your own stocks and portfolios, and measure performance against 
established market indices and other benchmarks. 
You can:

� Create index lists, X#ABC lists.

� Calculate indices, X%ABC lists.

You can create lists by selecting individual constituents, or using existing lists.

Master List.
Displays all index 
lists and indices.

Create 
New List.

View 
Usage 
Report.

Modify Index button. 
Click to edit, calculate, 
or delete your list.

Lists and indices 
available. 

Search for index 
list.

Refresh 
button.
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Trial and Auto indices

Trial indices – A trial index is an experimental or one off calculation. This is usually 
calculated within an hour. A trial index is not updated by Datastream.

Auto indices – An auto index is calculated automatically, by Datastream, every 24 
hours. This is calculated the day following its request and then every 24 hours.

Auto Halt indices

Indices are not deleted from the system. Please delete unused indices to minimise 
unnecessary calculations. If an index has not been used for 3 months, it is given Auto 
Halt status. 

To reinstate the auto calculation of an index with this status, see Reactivating an Auto 
Halt index, page 40.

Using indices created in DS Windows

If you are using indices created in DS Windows that include history and weighting 
(other than default), you can calculate the index in Advance, but you can not modify 
the list. These indices are marked with an asterisk after the list size.
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 Creating an index list

To create an index list

1 Select UCI Manager from the Tools menu.
The UCI Manager is displayed.

2 Select Create new list.
The List editor is displayed.

3 Type the list mnemonic, this must begin with a letter and can be up to 6 characters 
long. 

4 Type a description for the list.
5 Select the constituents for your list.

Click the Series navigation button to search for and select individual equities, 
index lists, or constituent lists from Datastream navigator.
OR
Click the List picker button to select a local or user list.

6 When you have selected your constituents, close navigator to return to the List 
editor.

Remove 
series from 
list button.

Clear 
selection 
button.

List picker 
button.

Series 
navigation 
button.

Save list 
button.

Invert 
selection 
button.
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7 You can use the Remove, Clear selection, and Invert selection buttons to 
amend your list.

8 Click Save when you have selected the constituents for your list.

You can now calculate, view, edit, or delete your list.

If your list is unsuccessful you are given the option to correct errors. 

Note:
You can also create an index list from a local list in the List Wizard. When you have created or 
edited a local list, you can select the option to save it as a local list and upload it to Datastream 
as an index list. 
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Calculating an index

To calculate an index, you must have created an index list. See Creating an index list, 
page 36.

To calculate an index 

1 Select UCI Manager from the Tools menu.
2 Find the index list you want to calculate and click the Modify index button.

3 Click the Request calculation button.
4 Type or select the base date.

This is the date for the starting value of the index. If data is not available from the 
selected base date, the earliest date for which data is available is used.

5 Select the end date (optional), for trial indices. For automatic indices, calculations 
are made to the latest date for which data is available. 

6 Select the calculation type, Trial or Auto, from the Calculation type drop down 
box.

7 Select the currency for the index from the Currency drop down box.
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8 Click the Submit request button.
Your index is sent for calculation.

Note: 
Your index will show Status: PEND in the UCI Manager until it has been calculated. You must 
refresh the screen to see if the status has changed. When it has been calculated, you can click 
View Status Report on the details screen, which gives you a report of the calculation results.

Viewing an index

To view an index:

1 Find the index you want to view and click the index mnemonic to select it.
The index selected is displayed in the Series display area.

2 Select the type of chart /report you want to view the index with.

You can also find your index using the Datastream Navigator:

1 Select User Created Indices from the Category drop down box.
2 Find the index you want to view, and click the index mnemonic to select it.

The index selected is displayed in the Series display area.
3 Continue from step 2 above.

Editing an index

To edit an index:

1 Select UCI Manager from the Tools menu.
2 Find the index list you want to edit and click the Modify Index button.
3 Click the Show/Edit constituents button.

The List Editor is displayed.
4 Click the Series navigation button to display Datastream navigator to select 

and add more constituents
OR
Click the List Picker button to select and add a list.

5 Use the Remove, Clear Selection, and Invert Selection buttons to amend the 
constituents in your list.

6 Click the Save button to save your changes.

You can also find your index using the Datastream Navigator:
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1 Select User Created Indices from the Category drop down box.
2 Find the index you want to edit.
3 Click the Modify Index button.

The UCI Manager is displayed.
4 Continue from step 3 above.

Deleting an index or index list

To delete an index or index list

1 Select UCI Manager from the Tools menu.
2 Find the index or index list you want to delete and click the Modify index button.
3 Click the Delete list/index button.

A confirmation dialog is displayed.
4 Click Yes to delete your list/index

You can also find your index using the Datastream Navigator:

1 Select User Created Indices from the Category drop down box.
2 Find the index you want to edit.
3 Click the Modify Index button

The UCI Manager is displayed.
4 Continue from step 3 above.

Recalculating an auto index

1 Select UCI Manager from the Tools menu.
2 Find the auto index you want to calculate and click the Modify index button.

The Details screen is displayed.
3 Click the Request Calculation button.

The Calculation Request screen is displayed.
4 You can change the base date, if you want to.
5 Click the Submit Request button.

The index status will be Auto Pend.

Reactivating an auto halt index

1 Select UCI Manager from the Tools menu.
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2 Find the auto halt index you want to reactivate and click the Modify index button.
The Details screen is displayed.

3 Click the Request Calculation button.
The Calculation Request screen is displayed.

4 Click the Submit Request button.

The index status will be Auto Pend.

Index Status

Trial Trial index
Trial Pend Trial index pending calculation
Trial Error Trial index error in calculation

Auto Auto index
Auto Pend Auto index pending calculation
Auto Error Auto index error in calculation
Auto New Auto index new
Auto Halt Auto index halted due to 

inactivity for 3 months
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User created time series

A user time series is a series of values (data) for different points in time created by you 
and uploaded for storage on Datastream. The values can be daily, weekly, monthly, 
quarterly, or yearly and you can save the series in management groups to help you 
organise them. You can use these series in Advance and AFO charts and reports. You 
can combine them with Datastream maintained series and use functions and 
expressions to manipulate them. An Excel template is used to create and edit your 
time series. You can download an existing series to form the basis of a new one.

The user created time series template:

Name The series name (up to 64 characters). 

Code The series code. Use this to retrieve your series in Advance and AFO. 
This must start with TS followed by 6 characters, eg TSUKRPI1.

Mgmt. Group Management group. 1 - 10 characters. You can have up to 200 series 
in a group, eg UK. 

Decimals The number of decimal places for your values.
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As % No indicates the series are actual values. Yes indicates the series are 
expressed as percentages. 

Freq. Conv. Determines the adjustment to make when you use a series at a lower 
frequency than it is stored. For example, using series stored with daily 
values in a request for weekly values.

Sum - Sum all values for a calendar period.
Avg - Average all values for a calendar period.
End - The value at the end of a calendar period.
Act - The actual value at the calendar intervals.

Date align. For data adjusted for frequency, select where in the calendar period 
to align the data for plotting.

1st - Plot data from the beginning of the calendar period.
Mid - Plot data from the middle of the calendar period.
End - Plot data from the end of the calendar period.

Carry ind. For null values. You can leave the values blank or carry forward the 
previous value.
Yes - carries the previous value. 
No - leaves the value at null.

Upload type When editing a series, you can upload only the values that have 
changed.

Full - uploads all the values in the series. 
Partial - uploads the values that have changed.

Set date range This is used to set the start and end dates, and the frequency for new 
series. Use this to change the end date when extending the series.

Optional:

Units A qualifying unit for your data. For example: tons, U$ millions, index.

Currency Select a currency for series with monetary values.

Other fields:

Start date The start date for the series data. 

End date The end date for the series data. Note, you can change this for 
Partial uploads - only data after the end date is uploaded.

Frequency The frequency of values: daily, weekly, monthly, quarterly, or yearly. 
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Creating a user created time series

To create a time series:

1 Select New UCTS table from the AFO>User created time series menu and save 
the workbook.

2 Type a name for the series.
3 Type the series code. This must start with TS followed by 6 characters, eg 

TSUKRPI1.
4 Type the management group you want the series to belong to (up to 10 

characters) eg UK.
5 Select the number of decimal places for display. Type the number, or select 

from the drop down box and click the Add button.
6 Type the units, (optional). This is a qualifying unit for your data. For example: tons, 

U$ millions, index.
7 Select As %. No indicates the values are actual values. Yes indicates the values 

are expressed as percentage. Used in the Latest Values and % change over 3 
periods report.

8 Select the type of Frequency conversion. This determines how the series is 
handled if you use it a lower frequency than it is stored. 

9 Select the Date alignment for data adjusted for frequency. 
10 Select a Currency for monetary values (optional).
11 Select the Upload type. Select Full to upload all the values. 

Use Partial to upload only the values that have changed when editing a series.
12 Set the date range. Click the Date range button and type the start and end dates. 

Select the frequency of the data: Daily, weekly, monthly, quarterly, or yearly.
The dates are displayed in the date range column, ready for values to be added.

13 Type your values against the dates displayed.
14 Click the Upload button to save your series. Note the cursor must be in the Code 

field to upload the series. You can highlight more than one series to upload 
several series at the same time. 

You can now use this series in Advance or AFO requests.
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Editing an existing user created time series

To edit a user created time series:

1 Select New UCTS table from the AFO>User created time series menu and save 
the workbook.

2 Click the Select code button. Note the cursor must be in the Code field.
Datastream navigator is displayed with the series set up on your Datastream ID.

3 Search for and select the series you want to edit. 
The selected series mnemonic is displayed in the Code field.

4 Click the Download button. Note the cursor must be in the Code field.
5 If you want to add new values, click the Set date range button and type a new 

end date. 
6 Make your changes and select the Upload type.

Use Full upload to overwrite all existing values.
Use Partial upload to update only the new values and change the date in the End 
date field to indicate the new values to upload.
Note: see tick box in Options dialog.

7 Click the Upload button to save the series. Note the cursor must be in the Code 
field.

To delete a time series:

1 Place the cursor in the Code field of the series you want to delete.
2 Click the Delete button to delete the series.

To add a new worksheet to the workbook:

If you want to download or upload a series with an earlier start date or a different 
frequency, add a new worksheet.

1 Click the New sheet button.
A new worksheet is displayed.

To configure the template:

1 Click the Options button.
The Options dialog is displayed.

2 Tick the Overwrite all values if series already exists box to overwrite existing 
values.

Note
The server for Navigator is configured via the AFO>Options menu.
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Using expressions and functions

About expressions and functions

Advance gives you access to Datastream’s standard expressions and functions, which 
you can use to form part of your chart, report or data requests. An expression is an 
individual Datastream code or series combined with datatypes and/or functions to 
create a mathematical formula. 

Expressions

For example, to find a share price and display it as a percentage of a price index:

Expressions are a powerful and flexible way of retrieving data from Datastream with 
variables and functions that you can choose to suit your needs. There are two forms; 
standard and symbolic:

Functions

Expressions can also contain Datastream functions, which enable you to manipulate 
Datastream data. A typical function, for example the Moving Average, has a mnemonic 
followed by parameters in brackets:

You can access a whole range of functions that you can build into your own 
customised expressions. For example, this symbolic expression has the function 
Percentage Change (PCH#) nested into the expression:

J:TYMO/AUTOSJP*100 the Toyota share price (J:TYMO) is expressed as a 
percentage of the Japanese motor industry price index 
(AUTOSJP).

Expression Example Description

Standard FTALLSH/UKRP....F This requests the FTA All share index with 
the inflationary element (RPI) removed.

Symbolic X(DY)/Y*100 This requests the dividend yield of variable X 
expressed as a percentage of variable Y, 
where X is an equity series and Y is a market 
index.

MAV#(BP,3M) this calculates a three month moving average for BP.

(PCH#(X(EPS)),Y) this calculates the earnings growth for an entered series X 
over an entered time period Y.
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To use an expression in a request:

1 Select an expression from the Expression Picker. See Selecting expressions, 
page 49. 

2 Select a chart or data format.

Expression selection and prompts for variables are displayed below the Chart/Report 
list on the Comparison tab. Each relevant entry is prefixed with fx

When you request a chart or data format with an expression, the result is displayed in 
the same way as for other requests, except that the expression is displayed in the 
legend.

Expression 
Builder button

Expression Picker 
button

Raise and Lower 
buttons

Add and 
remove 
buttons
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h 

 
d 
Using the Expression Picker

Use the Expression Picker to select expressions. Click the Expression Picker button, 
to display the Expression Picker dialog.

See also Selecting an Expression, page 49

A list of all the expressions available is displayed in the Expression Picker dialog. 
Each time you create a new expression this list is automatically updated. When new 
Datastream global expressions are created, you need to download them from 
Datastream using the Refresh facility.

You cannot edit a Datastream global expression, but you can use it as a starting point 
for making a new local expression.

Use the Show: drop 
down box to display: 
all, local, or global 
expressions.

Type the first few 
letters of the title, 
or expression in the 
Find: field to find 
your expression.

Click the Create New 
Expression button to 
display the Expression 
Builder to create new 
expressions.

Click the Edit button to 
edit an expression you 
have created in the 
Expression Builder. 

Click the Delete 
button to delete the 
selected expression 
from Datastream. 

Click the Refres
button to up-
date the list of
expressions hel
on Advance. 

 The Grid Last 
Downloaded: date 
and time, tells you 
when the list was 
last downloaded.
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Selecting an Expression

Use the Expression Picker to select Datastream global expressions, and your own 
created expressions. The Expression Picker button is displayed when you select the 
Comparison tab, and on the Flexible Report settings dialog. 

All expressions have a unique number, for easy recognition. Global expressions take 
the form xxxE and local expressions Exxx.

To select an expression:

1 Select the Comparison tab.
2 Click the Expression Picker button.

The Expression Picker dialog is displayed.
3 Use the Show: drop down box to display: all, local, or global expressions.
4 Select the expression want from the list displayed.

You can use Find: to search the list by Title or Expression.
5 Click OK to add the expression to the Comparison list. 

You can add the required series and select a report, chart, or data format.
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Using the Expression Builder

Use the Expression Builder to create and edit your own expressions. You can select 
the individual components that make up your expressions. Click the Expression 
Builder button to display the Expression Builder dialog.

The Expression builder

The work area where you 
build your expression. 
Each element of the 
expression is shown as 
an individual line, which 
you can edit.

The cursor draws a 
rectangular box around 
line elements that are 
logically grouped. For 
example, inserting the 
function LAG# into the 
expression also inserts 
a symbolic series X and 
a time period. If you 
delete LAG#, you will 
also delete the series 
and time period that 
belong to it.

A description of each 
line element is shown.

Type the expression title, 
which is displayed in the 
Expression Picker for 
selection.

Use the tool buttons 
to enter the 
individual elements 
(e.g. series, 
datatypes, numbers) 
that make up your 
expression.

The expression 
formula is displayed 
in the Expression 
field. You can type 
the  formula in the 
Expression field and 
press ENTER to 
expand the 
expression in the 
work areafor editing. You can save your 

expression to a number, 
For example Exxx.
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Tools available in the Expression Builder

 Function
The Select a Function dialog is displayed. Select a specific Datastream function, the 
function and its parameters (e.g., start and end dates) are inserted into the workspace 
area.

  Existing expression
The Expression Picker dialog is displayed. Select an existing Datastream global 
expression or local expression to add to your expression. For example, if you want to 
nest one expression into another. Only expressions with no symbolic substitution are 
allowed.

 Series

The Series Selection dialog is displayed. Select a ‘static’ or ‘symbolic’ series to add to 
your expression. You can use the Change Filter facility to select a simple or an 
extended series filter.

 Number

The Enter Number dialog is displayed. Add a number to your expression. A number 
occupies its own line in the workspace area, typically after a maths operator. Double 
click the displayed number to enter another value.

 Datatype

The Datatype Selection dialog is displayed. Add a datatype after a ‘static’ or 
‘symbolic’ series. You can use the Datatype dropdown list and mnemonic search to 
select and add a specific datatype.

 Currency
The Currency dropdown list is displayed. Select a different display currency for a 
‘static’ or ‘symbolic’ series. The currency you select is used for the new expression 
until you modify it.
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 Dates

Edit the start and end dates for a selected function. The work space cursor must be 
positioned over a date variable line. You have the same start and end date options as 
you have for normal requests.

 Math Operator 

Add parenthesis or maths operators to your expression. Position the workspace cursor 
at the insertion point and click an operator button.

 Delete

Delete parts of your expression. For example, details contained within parenthesis. 
Position the workspace cursor at the point of deletion and click this button to logically 
delete expression details.

 Undo

Undo your last action in the expression builder workspace. For example, undo the last 
series added to the workspace.

Expression Builder Menus

Expression menu

Open - opens the Expression Picker so you can select an existing expression 
for use within the Expression Builder.

New - clears the Expression Builder workspace, leaving you with a blank space 
to create a new expression.
Save - saves the expression displayed in the workspace area.

Close - quits the Expression Builder.

Edit menu

Undo - undoes your last create, delete, or edit action.

Delete - deletes whole functions or expressions that are nested.
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Tools menu

Function - The Function selection dialog is displayed. Select a specific 
Datastream function, the function and its parameters (e.g., start and end dates) 
are inserted into the workspace area.

Expression - The Expression Picker dialog is displayed. Select a Datastream 
global expression or a local expression to add to your new expression. For 
example, if you want to nest one expression in another. 

Series - The Series Selection dialog is displayed. Select a ‘static’ or ‘symbolic’ 
series to add to your expression. You can use the Change Filter facility to select a 
simple or an extended series filter.
Number - The Enter Number dialog is displayed. Add a number to your 
expression. A number occupies its own line in the workspace area, typically after 
a maths operator. Double click the displayed number to enter another value.

DataType - The Datatype Selection dialog is displayed. Add a datatype after a 
‘static’ or ‘symbolic’ series. You can use the Datatype dropdown list and 
mnemonic search to select and add a specific datatype.

Currency - The Currency dropdown list is displayed. Select a different display 
currency for a ‘static’ or ‘symbolic’ series. The currency you select is used for the 
new expression until you modify it.
Date - Edit the start and end dates for a selected function. The work space cursor 
must be positioned over a date variable line. You have the same start and end 
date options as you have for normal requests.

Math Operator - Add parenthesis or maths operators to your expression. Position 
the workspace cursor at the insertion point and click an operator button. 
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Creating a Standard Expression

A standard expression contains series in a ‘static’ form, that is the series you select for 
the expression will be used each time you issue the expression request. For example, 
the Glaxo Wellcome stock and the FTSE All Share will be used each time you select 
this standard expression:

GLXO(PE)/FTALLSH(PE)*100
Standard expressions vary in their use and complexity. The following procedure shows 
you how to create the above expression, which calculates the price earnings ratio 
relative to the FTSE all share index.

To create a standard expression:

1 Select the Comparison tab on the Request screen.
2 Click the Expression Builder button. The Expression Builder dialog is 

displayed.
Select a series:

3 Click the Series button. 
4 Un-check the Use as Symbolic check box, to use the series you select in a 

‘static’ form. 
5 Select Equity from the Series dropdown list.
6 Search for the Glaxo Wellcome equity series and select it.
7 Click OK.

A warning message is displayed asking you to confirm your choice. Click Yes to 
confirm.

Select a datatype:
8 Click the Datatype button.

The Datatype navigator is displayed.
9 Search for and select the Price Earnings datatype. 

Add the math operator for division:
10 Click the Maths Operator button and select the / sign for division.
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Select a series:
11 Click the Series button
12 Un-check the Use as Symbolic check box, to use the series in its static form.
13 Select Index from the Series dropdown list.
14 Search for the FT All Share indices series and select it. 
15 Click OK. 

A warning message is displayed asking you to confirm your choice. Click Yes to 
confirm.

Select a datatype:
16 Click the Datatype button.

The Datatype navigator is displayed.
17 Search for and select the Price Earnings Ratio datatype. 

Add the math operator for Multiplication:
18 Click the Maths Operator button and select the * sign for multiplication.
19 Click the Add Number button, type 100, and click OK.
20 Click OK to save your completed expression.

If your expression is complete, logical, and contains no errors, Advance uploads the 
expression onto Datastream and assigns the expression a unique code. The 
expression is now copied to the comparison request window where you can make your 
comparison request.
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Creating a Symbolic Expression

A symbolic expression contains symbols, for example X and Y, instead of actual 
series. You supply the details for the symbol each time you use the expression. You 
can only substitute series for the symbols in a symbolic expression, and not datatypes 
or time periods.

In the following example, X and Y are two equities, with the dividend yield of X 
expressed as a percentage of the dividend yield of Y.
X(DY)/Y(DY)*100
When you initially create this expression, you must specify a series for both X and Y, 
so that Datastream can check the logic of the expression before assigning it a unique 
number. Once the expression has been checked and saved, you specify the series of 
your choice for X and Y each time you issue a request.

Symbolic expressions vary in their use and complexity. The following procedure shows 
you how to create the above example. If you wish to create a symbolic expression 
using Datastream functions, refer to Datastream Definitions on the Advance Help 
menu for descriptions of the Functions available.

To create a symbolic expression:

1 Select the Comparison tab on the Request screen.
2 Click the Expression Builder button. 

The Expression Builder dialog is displayed.

Select a series:
3 Click the Series button. Ensure that the Use as Symbolic check box is checked. 
4 Select Equity from the Series dropdown list.
5 Select an equity series.
6 Click OK.

Select a datatype:
7 Click the Datatype navigation button.

The Datatype navigator is displayed.
8 Search for and select the Dividend Yield datatype. 

Add the math operator for division:
9 Click the Maths Operator button and select the / sign for division.
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Select a series:
10 Click the Series button. Ensure that the Use as Symbolic check box is checked. 
11 Select Equity from the Series dropdown list.
12 Select an equity series.
13 Click OK.

Select a datatype:
14 Click the Datatype navigation button.

The Datatype navigator is displayed.
15 Search for and select the Dividend Yield datatype. 

Add the math operator for multiplication:
16 Click the Math Operator button and select the * sign for multiplication.
17 Click the Add Number button, type 100, and click OK.
18 Click OK to save your completed expression.

If your expression is complete, logical, and contains no errors, Advance uploads the 
expression onto Datastream and assigns the expression a unique code. The 
expression is now copied to the comparison request window where you can select 
new series for the symbolic elements of the expression and make your comparison 
request.
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Editing an Expression

You can edit a ‘local’ expression, an expression created by you or by users in your 
group. If you do edit an expression that is used in a shared network environment, the 
expression is changed for other group users as well as for you.

� Change series

You can change a static series for another series by simply selecting the series in 
the Expression Builder workspace, clicking the Series button and selecting and 
applying another static or symbolic series. 

You can delete a series, care must be taken as the delete function will delete 
whole functions or expressions that are nested.

� Change numbers

You can change a number to a higher or lower value by double clicking the 
number in the workspace and entering a new value in the Enter a Number dialog.

� Change maths operators

You can change maths operators. Double-click the operator in the workspace and 
then select a different operator from the pop-up button bar. You can either replace 
the operator with the new sign or insert the new sign so that it is appended to the 
end of the current block.

� Change datatypes

You can change datatypes by double-clicking on the datatype in the workspace. 
The Datatypes Navigator is displayed. Search and select a new datatype.

� Change date range of Function

You can change the default date range by double clicking the time period and 
selecting a new period or date range.

� Change currency of series

To change the displayed currency, select the series in the workspace and click on 
the Currency button. Choose a currency from the displayed dropdown list and 
click OK.
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Customising your charts and reports

You can customise your reports and charts to suit your needs. You can change the 
style, colour and thickness of any or all default line settings for your charts, and adjust 
the default background colour, grid, and fill styles.
You can add additional lines, shapes, text, and fills using Annotations to bring an 
extra dimension to your hard copy. Text for both charts and reports can also be 
changed to any default typeface, point size and style. For example, you can:

Change the column headings to a 
different font (Times Roman).

Change the body text to a clean 
(e.g. Helvetica, 10pt, normal) and 
readable style.

Adjust the report heading (e.g., 
Helvetica, 12pt, bold) to give all 
your reports a prominent and 
consistent heading style.

Adjust the 
background colour, 
grid or block fills to 
any desired colour 
or fill style.

Add new text to 
the chart using 
Annotations and 
emphasise it using 
a shaded box or an 
ellipse. You can 
also move any 
default text 
around and change 
its style.

Change the line styles to different thicknesses and colours, for 
visual recognition on screen and on paper.
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Overview of Properties and Annotations

You can customize the appearance of your charts and reports using Annotations and 
Properties from the Tools menu.

Annotations

Select Display Annotation Toolbar from the Tools menu, or right click over the 
display area, or click the Annotations button on the main toolbar.

Use the Annotations tool bar to add additional text, lines, arrows, shapes and fills to 
individual charts. You can specify a colour for any of these attributes.
Templates

When you annotate your charts, the style can be saved in a template. The template 
can be used with other charts without affecting the default styles set up in Properties. 
For example, you could create a company logo using Annotations and save it in a 
template for use with every chart you produce.

When you have saved your annotations in a template and have loaded the template 
with the current request, the annotations can be turned on and off by selecting Show 
Annotations from the View menu.
See Using Annotations, page 65. 

Properties

Select Properties from the Tools menu, or right click over the display area.

Use Properties to change the default styles of text, lines, arrows, shapes and fills for 
ALL your charts, reports, and data requests. When you change the styles using 
Properties, all subsequent chart, report or data requests use the new styles. This is 
useful if you want to produce a range of charts, reports and data with a common style.

Each style can be applied to a named attribute; for example, Report Title for reports, 
First Line for charts.
See Using Properties, page 61. 
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Using Properties

You can change the default appearance of all your chart, report, and data requests 
using the Tools>Properties menu. Each request type has its own settings screen. For 
example, if you select Properties while a chart is displayed, the Default Chart 
Properties screen is displayed. The changes you make on the chart properties dialog 
will affect all charts, similarly for reports and data requests. You can save these style 
schemes for reuse or to share with other users, for example a common house style.

You can:
� Change the line styles for charts 
� Change the fill styles for charts 
� Change the text styles for charts
� Change the text styles for reports
� Change the text styles for data requests 
� Save style schemes 
� Export and import style schemes

Saving style schemes

You can save the styles you select in properties and apply them to projects scheduled 
in the night shift facility. 

To save a new style scheme:

1 Select Properties from the Tools menu.
The Default chart properies dialog is displayed.

2 Click the Save As… button.
The Save Scheme as dialog is displayed.

3 Select the Create New Scheme option.
4 Select Local or Shared from the drop down box.

If a shared folder is not displayed, add a file location for shared chart style 
scheme in the Tools>Options>File locations dialog.

5 Type the name of your style scheme and click OK to save the styles set.

To overwrite existing style schemes:

1 Click the Save As… button.
The Save Scheme as dialog is displayed.

2 Select the Overwrite Existing Scheme option.
3 Select the scheme you want to overwrite from the drop down list.
4 Click OK to save the new style.
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To export a style scheme:

1 Select Properties from the Tools menu.
The Default chart properies dialog is displayed.

2 Click the Save As… button.
The Save Scheme as dialog is displayed.

3 Select the Export to Scheme File option.
4 Click the Browse button.
5 Select the directory to save the scheme in.
6 Type the file name.
7 Click the Save button.

To import a style scheme:

1 Select Properties from the Tools menu.
The Default chart properies dialog is displayed.

2 Click the Scheme drop down box.
3 Select Read Style Scheme File from the list displayed.
4 Select the file name.
5 Click the Open button.
6 Click OK.

Changing the line styles for charts

To apply different line styles:

1 With a chart displayed in the results screen, select Properties from the Tools 
menu. The Default Chart Properties dialog is displayed.

2 Select the Chart Line Styles tab. 
3 Select the following line attributes for the required line type (e.g. upward trend):

• Style - click on a style button.
• Colour - click on a colour button. More colours are available by clicking the 

More... button.
• Thickness - move the scroll bar to increase/decrease the line thickness.

4 Click OK.

Note:
Intermediate grid lines in flexible charts use the properties set for line eight.
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Changing the fill styles for charts

To apply different background colour and patterns to your charts:

1 With a chart displayed in the results screen, select Properties from the Tools 
menu. The Default Chart Properties dialog is displayed.

2 Select the Fill Styles tab.
3 Select the fill you want to change (e.g. Screen, first fill, etc).
4 Click the fill drop down box and select:

• Colour - click on a colour button. More colours are available by clicking the 
More... button.

• Fill effects - select pattern or gradient, select your style and colours, and click 
OK.

5 Click OK.

Changing the text styles for charts

To change the text styles for charts:

1 With a chart displayed in the results screen, select Properties from the Tools 
menu. The Default Chart Properties dialog is displayed.

2 Click the Chart Text Styles tab. 
3 Select the following text attributes for the required text type (e.g. Title):

• Font 
- click on the Change... button
- select a Font (e.g. Times New Roman)
- select a Font style (e.g. bold, italic, etc.)
- select a point size or scale
- click OK

• Text colour
- click on a colour button. More colours are available by clicking the More... 
button.

4 Click OK.

Note:
For changing the point size of chart text styles, you can use the Font Scaled dropdown list to 
determine the correct scaling (e.g. small, medium, large).
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Changing the text styles for reports

To change the text style for reports:

1 With a report displayed in the results screen, select Properties from the Tools 
menu. The Report Properties screen is displayed.

2 Select the following text attributes for the required text type (e.g. Report Title):
• Font details

- click on the Change... button, 
- select a Font (e.g. Times New Roman)
- select a Font Style (e.g. bold, italic, etc.)
- select a Point Size
- click OK

• Text colour
- click on a colour button

3 Click OK.
4 Select the grid display options, if required:

- click the Show Grid Lines check box to break up the report into spreadsheet 
type cells or grids
- click the Show Grid Row Headers check box to display row heading references 
(1, 2, 3 and so on), if you are using Show Grid Lines
- click the Show Grid Column Headers check box to display column heading 
references (A, B, C and so on), if you are using Show Grid Lines

5 Click OK.

Changing the text styles for data requests

To change the size, style, and colour of the text in your data channel request, for 
example the text displayed in your Time Series Data, Static Data, and Company 
Accounts Data requests:

1 With a data request displayed in the results screen, select Properties from the 
Tools menu. The Data Channel Properties screen is displayed:

2 Select the following text attributes for the required text type (i.e. Data Channel):
• Font details

- click on the Change... button 
- select a Font (e.g. Times New Roman)
- select a Font Style (e.g. bold, italic, etc.)
- select a Point Size
- click OK

• Text colour
- click on a colour button.

3 Click OK.
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Using Annotations

The Annotations toolbar is available when a chart is displayed in the results screen. 
Select Display Annotations Toolbar from the Tools menu.

 Template

Open an existing template. The Load Template dialog is displayed. Templates have 
the file extension *.MDB. When you load a template, annotations are displayed over 
your chart or report.

 Save Template
Save the annotations on your chart as a template. The Save Template dialog is 
displayed. The template must be saved with the file extension *.MDB.

Text

 Text button 

Type text annotations on your chart. Click the Text button, then click where you want 
to put your text. Drag the cursor downward to increase the point size. Type your text 
and press ENTER. When you select this text, you can use Font and Font Size from 
the Text Tool Bar to change the text style.

 Text Colour
Select the default font colour. Click the Font Colour button and select the colour you 
want from the drop down palette. 

 Show Text Tool Bar
Display or hide the Text Tool Bar.

Drawing Objects

 Select Objects 
Select text or graphic objects.
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 Line
Draw a line; click where you want to start, drag to where you want to finish, and 
release

 Arrow
Draw a line with arrow ends

 Rectangle
Draw a rectangle; click where you want to start and drag to size. 
To draw a square, hold down SHIFT and drag.

 Oval 
Draw an Oval; click where you want to start and drag to size. 
To draw a circle, hold down SHIFT and drag.

 Free Rotate
Rotate a selected object. Select the object, click Free Rotate and drag a corner to 
rotate the object.

Fill and Line Styles

 Fill Colour and Fill Effects
Add, modify, or remove the fill colour or fill effect from the selected object. See Fill 
Effects, page 68.

 Line Colour
Add, modify, or remove the line color from the selected object.

 Text Colour
Change the colour of the selected text.
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 Line width
Change the line width for the selected object, lines, arrows, boxes and circles.

 Arrow Style
Change the Arrow style for the selected object

Object positioning

 Bring to Front
Brings the selected object in front of other overlapping objects. 

 Send to Back
Sends the selected object behind other overlapping objects. 

Editing Tools

 Cut 
Removes the selection from the active document and places it on the Clipboard.

 Copy 
Copies the selected objects to the Clipboard.

 Paste
Inserts the contents of the Clipboard at the insertion point, and replaces any selection. 
This command is only available if you have cut or copied an object to the clipboard.

 Reset Objects 
Delete changes to your chart or delete all additional annotations. Click the appropriate 
option and click OK. If you decide to delete all additional annotations, a confirmation 
screen is displayed.
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 Undo
Undo last annotations that have been applied to a chart.

 Redo
Redo last undo

Note:
Changes made to default text and chart properties will not be saved in a template.

Fill effects

You can apply a foreground pattern and colour and a background colour to fill selected 
objects. Select Fill Effects from the Fill Colour button drop down palette. The Fill 
Effects dialog is displayed.

To apply a pattern and colours:

1 Select the Patterns tab.
2 Select the fill pattern you want.
3 Select a foreground colour from the Foreground: drop down palette.
4 Select a background colour from the Background: drop down palette.
5 Click OK.

To apply a gradient fill:

1 Select the Gradient tab.
2 Select the colours you want.
3 Select Horizontal or Vertical gradient.
4 Select the fill style.
5 Click OK.
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Format Object

You can format colours, lines, arrow styles, and text on selected objects. Right click 
the mouse and select Format Objects from the menu. The Format Object dialog is 
displayed.

To format fill colour, line colour and width and arrow styles:

1 Select the Colours and Lines tab.
2 Select the fill colour from the Colour: drop down palette in the Fill section.
3 Select the line colour from the Colour: drop down palette and line width from the 

Width: box in the Line section. 
4 Select the arrow styles from the Begin style: and End style: drop down boxes 

and the size from the Begin size: and End size: drop down boxes in the Arrows 
section.

5 Click OK.

To format text styles:

1 Select the Text tab.
2 Select the text styles you want from the dialog.
3 Click OK.
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Remove Chart Changes

You can reset original chart elements and remove user added annotations for the 
whole chart or for selected objects. Click the Reset Objects button or right click the 
mouse and select Reset Objects from the menu. The Remove Chart Changes dialog 
is displayed.

To Remove chart changes:

1 Select Reset Original Chart Elements and /or Remove User-Added 
Annotations from the Action section. 

2 Select The Whole Chart or The Selected Elements only option from the 
Perform Action On section.

3 Click OK.
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Using flexible chart

Why use flexible chart?

Flexible chart gives you the flexibility to create your own chart layouts in Advance. 
Once you have created your layouts, you can store them for use with other series 
using favourites, see using favourites, page 97.

Flexible chart enables you to create multiple chart layouts with multiple series plotted 
using a variety of different chart types and styles.

You can:
� Create layouts with up to four graphs per chart.

� Plot up to 8 series on one graph, or 12 series over more than one graph.

� Select series from different data categories, with different datatype and currency 
settings.

� Select from straight line plots, thin and composite bars, candlesticks and high/low/
close plots for each series plotted.

The amount of data and flexibility with which you can present it, lends itself to the 
creation of business studies or detailed comparisons. For example, you could compare 
the performance of four similar stocks on one graph, show the performance of the 
market index on another graph and finally show several economic indicators for the 
relevant country on a third graph. 

The charting options, accessed from the Settings wizard, enable you to quickly build 
up charts from simple layouts to quite complex formats with shading and grid styles. 
The following section shows you the kind of things you can do with this powerful tool.
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Flexible chart features

The following example is an equity study examining the stock price movements of a 
leading UK retailer. The study was produced using a flexible chart pre-formatted 
template and illustrates the different chart styles and options you can select.

You can:

� Choose from 8 pre-formatted templates, for example Four Graphs - 25%, 25%, 
25%, 25% as shown here.

� Specify a title for the whole chart, a title for each individual graph, and display 
today’s date.

� Use the default series name for the legends or display your own legend 
descriptions.

� Plot up to eight series on one graph.

� Select from four rebasing options for multi-series comparisons. For example, 
rebased to 100 as shown here.

� Set a different display period for each graph.

� Set the scale for both left and right-hand Y axis scale for each graph. Use the 
default optimum ticks for the X axis or specify your own customised ticks. 

� Select individual chart types for each series to be plotted. The FTSE100 shown 
here is plotted using a high/low/ close chart.
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Multi-graph layouts and positioning

The flexible chart facility, unlike other Advance charts, gives you greater flexibility in 
the way you can lay out your plotting information. You can choose from eight pre-
formatted templates or design your own customised layouts.

� Pre-formatted templates

Eight pre-formatted templates are provided to enable you to quickly create a multi-
graph layout. The layouts range from simple single graph layouts through to four 
graph layouts. The types of layout available is dependent upon the number of 
series you select. For example, if you have selected two series, then only the first 
four of the following pre-formatted templates are available for selection:
• Single Graph - suitable for comparing up to eight series in line plots
• Two Graphs 70% and 30% - suitable for combining graph types where the top 

reserved area could be used to display a wider Y scale or display bars
• Two Graphs 50% and 50% - suitable for comparing like with like, e.g. 

comparing the price performance of two stocks as line plots and candlesticks
• Three Graphs 50%, 25%, 25% Horizontal - suitable for producing three graph 

studies where room for the X axis is needed
• Three Graphs 25%, 50%, 25% Vertical - suitable for producing three graphs 

studies where room for the Y axis is needed
• Three Graphs 50%, 25%, 25% - suitable for producing three graphs studies 

where space is maximised
• Four Graphs 25%, 25%, 25%, 25% - suitable for producing four graph studies 

up to a maximum of 12 series plotted.

� Customised layouts

• You can also create your own templates using the settings wizard. You can 
create custom layouts including up to four graphs in one chart. For each chart, 
you can specify the x and y positioning and watch your new graph take shape 
in a display window. See Customising chart layouts, page 80.
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Graphs with different display periods and plotting frequencies

For single graph layouts or custom single graphs, as with most Advance charts, you 
can use the Select Date facility on the Request screen to determine the default display 
period for your requests. The default could be:

� A period of days, months and years in the past relative to today’s date or latest 
available date/time where data is available (i.e., an intraday pricing point). This 
relative period could start on the Datastream base date for the series.

� A fixed period of days, months and years in the past.

� A number of year ends for retrieving company accounts data.

All these display period options are available to you when using the flexible chart 
facility. 
If you are using layouts with multiple graphs you can override the default display 
period and set individual start/end dates for each graph. The Customise individual start 
and end for all graphs option on the settings wizard enables you to use the Select Date 
facility on each graph’s Graph Settings wizard.

This feature is useful if you want to analyse, for example, the performance of several 
stocks over a short time period and compare this performance against a background 
economic indicator over ten years.

Whatever display period you choose, a default plotting frequency is automatically 
assigned to help keep the number of line plots to a practical number.
� Period of up to two years, the plot frequency is daily

� Period of up to 10 years, the plot frequency is weekly

� Period of over 10 years, the plot frequency is monthly
The Frequency option on the Graph Settings wizard enables you to override the 
default plotting frequency with daily, weekly, monthly, quarterly and yearly plotting 
frequencies. You could, for example, display the performance of a bond over two years 
using a monthly plotting frequency instead of a daily plotting frequency.

Note:
Care must be taken when using display periods and plotting frequencies so that you get exactly 
the data that you need. Datatypes for certain series can only be plotted at set frequencies. For 
example, some Economic series are only available on a monthly, quarterly or annual basis, and 
company accounts series (including third party company accounts) are only available on an 
annual basis. When using series plotted with the high/low/close, daily closing price information 
must be available for the selected series. When you have selected an inappropriate display 
period or plotting frequency, you will receive a warning, e.g. Sorry this request has failed - 
SELECTED TIME PERIOD IS TOO LONG FOR...
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Assigning different series and properties to each graph

You can set individual series, graph, and axis properties for each series in each graph 
you have set up for your chart, using dedicated settings screens. This means that 
each series can be plotted in a different way on the same graph, and each graph can 
have its own display properties.

� Series Settings

You can specify the following for each series:
• Your own line legend or default legend using the series title 
• Display series on left or right-hand axis
• Choose from 9 chart types including line chart, line chart with fill below line, 

line chart with fill above line, line chart with shading around line, bar chart, 
composite bar chart, thin bar chart, candlestick and high/low/close chart.
See Setting individual series properties, page 82.

� Graph Settings

You can specify the following for each graph set up for the chart layout:
• Display period (overriding the default display period for the data category)
• Your own graph title or default title using the series title 
• Choose from four rebasing options including displaying actual values, all 

series rebased to start at 100 and second series rebased to first
• Display high, low and last price information for each series at the bottom of the 

graph (one graph only)
• Choose between three grid styles
• Override default plotting frequencies with a choice of daily, weekly, monthly, 

quarterly and yearly frequencies
See Selecting individual graph properties, page 83.

� Axis Settings

You can specify the following for each graph:
• Display Y axis scale on both left and right-hand axes
• Specify Y axis scale as either linear or logarithmic
• Choose to display X axis with optimum ticks or override default ticks with daily, 

weekly, monthly or yearly ticks
• Specify the scale range for the X and Y axes

See Selecting axes properties, page 85.
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Making flexible chart requests

The following procedure shows you how to make a basic flexible chart request.

To make a basic flexible chart request:

1 Select the Comparison tab.
2 Select the Flexible Chart tool from the list displayed.
3 Select a data category from the Category drop down box.
4 Select a series. See Selecting a series, page 3.
5 Select a datatype, if a datatype other than the default is required. See Selecting a 

datatype, page 13.
6 Click the Add Series button to add the selected series (and datatype) to the 

comparison request list.
7 Repeat steps 3 to 5 for each series you want to appear on the chart(s) (up to a 

maximum of 12 series). 

Add 
series

Remove 
series

Clear 
all

Move series 
up or down

Settings 
button

Expression 
Builder

Expression 
Picker
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8 Click the Settings button. Back to: Flexible charts and lists 
The Chart Wizard is displayed.

9 Select your chart layout. Click the Change Chart Layout… button, if you want to 
change the default pre-formatted chart template or create your own customised 
layout. For details on creating your own chart layouts, see Customising Chart 
Layouts, page 80. 

10 Select your date display options.
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11 Type a chart title in the Chart Title field if you are using a layout with more than 
one graph.
You can use the Properties settings to enter a title for each graph.

12 Click Next. 
The Assign Series to Graphs dialog is displayed.

13 Select the series to be displayed on the graphs for the selected layout:
• Select the graph.
• Select the series you want to display on the graph.
• Click the Add button to add the selected series to the graph, or double-click 

the series.
• You can remove any series from the graph. Select the series in the graph list 

and click the Remove button, or double-click the series.
14 You can raise and lower each series in the graph list by selecting a series and 

clicking the Raise and Lower buttons.
15 Select the Series, Graph, and Axis Settings for each graph:
16 Click a graph tab.

• Click the Properties... button.
• Click the Series Settings tab and select series settings for each series.

See Setting individual series properties, page 82 for details.
• Click the Graph Settings tab and select the graph settings.

See Selecting individual graph properties, page 83 for details.
• Click the Axis Settings tab and select the axis settings.

See Selecting axis properties, page 85 for details.
17 Repeat the above steps for each graph in your chart.
18 Click Finish to save your flexible chart settings.
19 If you selected individual display periods for each graph, the following message is 

displayed in the Date field:
Set dates per graph via flexible chart settings

20 Click Run Now to make your flexible chart request.

When the result is displayed, you can:

� Click the Add Request button to add the request to the current open Project. You 
can then schedule this request for future, overnight refreshing using Night Shift, 
or refresh the request on an ad hoc basis using the Navigator or Project screen.

� Click the Favourites button to create a Favourite. This enables you to identify and 
select the request from the Favourites dropdown list, and change the first series 
(and datatype), if the symbolic option is used.
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Making a flexible chart request for a list of series

You can use lists in a flexible chart request to create either:

� a chart of 1 to 4 graphs for each item in the list
� a chart with more than one line plotted on each graph. From two lines per graph 

on a 4 graph chart, to 8 lines on a single graph chart 

To create a chart for each item in a list 

1 Select the Comparison tab.
2 Select the Flexible Chart tool from the list displayed.
3 Select local lists or constituent lists from the Category drop down box.
4 Select a local list from the lists displayed or use Navigator to find a constituent list. 

See Selecting a series, page 3.
5 Select a datatype, if a datatype other than the default is required. See Selecting a 

datatype, page 13.
6 Click the Add Series button to add the selected list to the comparison request list.  

Add the list once for each graph in the chart. For example, once for a single graph 
chart, twice for a two graph chart, up to four etc. 
Note: If you are adding the list more than once, a dialog asking if you want to use 
the multi-line option is displayed. Click No.

7 Continue from step 8 of the procedure: To make a chart request, page 77.

To create a chart of multi-line graphs

1 Select the Comparison tab.
2 Select the Flexible Chart tool from the list displayed.
3 Select local lists or constituent lists from the Category drop down box.
4 Select a local list from the lists displayed or use Navigator to find a constituent list. 

See Selecting a series, page 3.
5 Select a datatype, if a datatype other than the default is required. See Selecting a 

datatype, page 13.
6 Click the Add Series button to add the selected list (and datatype) to the 

comparison request list. 
7 Continue to add the list, up to a maximum of 8 instances, depending on how many 

lines you want per graph. A dialog asking if you want to use the multi-line chart 
option is displayed. Click Yes.
Adding the list 8 times for a single graph chart gives 8 lines on one graph, 8 times 
for a two graph chart gives four lines per graph, etc.

8 Continue from step 8 of the procedure: To make a chart request, page 77.
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Customising chart layouts

You can create your own chart layouts using the Configure manually option in the 
Flexible Chart wizard. Click the Change Chart Layout... button on the opening 
wizard screen and select the Configure Manually tab.

� The left window displays the current graph position of the graphs selected. The Y 
and X axis scales show the co-ordinates of each graph. As you change these co-
ordinates, you can watch the graph position move in this window.

� You can change the co-ordinates for each graph. Click the respective check box 
on the right and change the co-ordinates using the up and down buttons. If you 
have only two graphs, you can check the other graph check boxes to display other 
available positions.

To create a three graph layout with ‘white space’ around each graph: 

1 Select the Comparison tab.
2 Select the Flexible Chart tool from the list displayed.
3 Select a data category and select a series. See Selecting a series, page 3.
4 Select a datatype, if a datatype other than the default is required. See Selecting a 

datatype, page 13.
5 Click the Add Series button to add the selected series (and datatype) to the 

comparison request list.
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6 Repeat steps 3 to 5 for each series you want to appear on the chart(s) (up to a 
maximum of 12 series). 

7 Click the Settings button. 
The Chart Wizard is displayed.

8 Click the Change Chart Layout... button.
9 Click the Configure Manually tab.
10 Click the check boxes for Graph1, Graph 2 and Graph 3.
11 For Graph 1, use the up and down buttons to set the co-ordinates to Left 7, Right 

92, Bottom 57, and Top 100. 
12 For Graph 2, set the co-ordinates to Left 7, Right 48, Bottom 1, and Top 50.
13 For Graph 3, set the co-ordinates to Left 52, Right 92, Bottom 1, and Top 50.
14 Click OK to confirm your custom settings. The Chart wizard now confirms your 

new customised chart layout.

The new custom format can be used along with the other series, graph, and axis 
settings.
Datastream Advance version 4.0, Issue 1 81



Advance User Guide
Setting individual series properties

You can select chart attributes for individual series for one graph at a time. 

To set individual series properties:

1 With your chart layout selected and your series assigned to each graph (see 
making flexible chart requests, page 76 steps 1 – 11)

2 Select a Graph tab on the Assign Series to Graph dialog.
3 Click the Properties... button. 

The Properties dialog is displayed.

4 Select the Series Settings tab.
5 Select a series from the displayed list. 
6 Either type your own Line legend description (up to 24 characters), or select a 

legend type from the Legend Options dropdown list.
7 Select an Axis Display option.
8 Select a chart type. As you click on an example, a description of the chart type is 

displayed. 
If you choose Bar Chart or Composite Bar Chart, you can centre the bars 
around the middle or end of financial years for company accounts.

9 Click OK to confirm your settings
OR
Click the Graph Settings or Axis Settings tabs to continue.
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Selecting individual graph properties

The Graph Settings screen within the settings wizard enables you to select attributes 
that affect the way data is displayed on the graph. The properties are assigned to one 
graph at a time.

To select individual graph properties:

With your chart layout selected and your series assigned to each graph (see making 
flexible chart requests, page 76 steps 1 – 11).

1 Select a graph tab on the Assign Series to Graph dialog.
2 Click the Properties... button.

The Properties dialog is displayed.
3 Select the Graph Settings tab.

4 Click the Select Date button.
The Configure Dates dialog is displayed.

5 Select a fixed or relative display period. 
See Display period adjustments, page 11 for details. If you have selected a single 
graph layout, you can ignore this option as the display period will be set by the 
default on the Request screen.

6 Type a title for the graph (up to 60 characters) in the Graph Title field. 
If you have selected a single graph layout, this title is the title of the chart. Click 
the Use First Series as Title check box to use the Datastream series name of the 
first series as the title.
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7 Select one of four rebasing options from the Rebased to: drop down list.
8 If you have selected a single graph layout, you can display high, low and last price 

information for up to four series. Select the display options from the Display high, 
low and last: drop down list. For multi-graph layouts, this option is not available.

9 Click a Grid Display button to choose a grid style. If you select a horizontal grid 
type, you can display intermediate Y axis grid lines.

10 Move the Frequency slider to increment, or decrement the plotting frequency of 
the graph. 
This overrides the default plotting period assigned by Datastream for the display 
period.

11 Click OK to confirm your settings
OR
Click the Series Settings or Axis Settings tabs to continue.
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Selecting axes properties

The Axis Settings screen within the settings wizard enables you to determine how the 
Y and X axes are displayed on each graph of your multi-graph layout. The axis 
settings need to be made for each graph you have set up, however you can just 
accept the default settings.

To select axes properties:

With your chart layout selected and your series assigned to each graph (see making 
flexible chart requests, page 76 steps 1 – 11).

1 Select a graph tab on the Assign Series to Graph dialog.
2 Click the Properties... button.

The Properties dialog is displayed.
3 Click the Axis Settings tab.

4 You can display or turn off the Y axis scale. Select options from the Y Axis 
Settings dropdown list. If you display the Y axis, you can display the scale on the 
right-hand side of the graph and select the type of scale from the Y Axis Scale 
dropdown list.

5 You can display or turn off the X axis. If you click the Display X Axis check box, 
you can choose to display Optimum ticks (default), or Customised ticks from 
the drop down list.
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6 If you display the Y axis, you can select the start and end of the Y axis scale for 
the Left hand and Right hand axes. 
This is useful if you want to bring the line plot into a tighter range to make it 
legible.

7 If you are plotting a number of series on one graph and intend to plot them on 
different right and left-hand scales, you can invert the axis. Check the Invert axis 
check boxes.
This is useful for comparing the relative performance of opposing series.

8 Click OK to confirm your settings
OR
Click the Series Settings or Graph Settings tabs to continue.
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Using symbolic series in flexible chart requests

You can use Favourites with Flexible Chart to create a chart that uses a symbolic 
first series. For example, you could use this chart to compare equity series against 
indices.

To create a flexible chart tool with a symbolic series:

Create your flexible chart layout as required and make the request (see Making 
flexible chart requests, page 76).

1 The position of the series in the list on the Assign Series to Graphs screen is 
important; the first series in the list for Graph 1 is the series that is used 
symbolically.

2 Click the Favourites button. 
The Favourites dialog is displayed.

3 Type a title for your flexible chart tool and click the Create first series as 
symbolic check box.

4 Click Save to save your new flexible chart tool.
The Set annotations dialog is displayed.

5 Select:
from a template to apply annotations from a template
from current request to save the annotations applied to the current request
no annotations to save without annotations.

6 Click OK.
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To issue a flexible chart request using a different first series:

1 Select the required flexible chart tool from the Favourites dropdown list. The 
series, datatype, and date parameters are displayed.

2 Select your series. See Selecting a series, page 3.
This series is now displayed in the comparison request list next to the heading 
Symbolic.

3 Click Run Now to make your flexible chart request.
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Converting and creating 401X formats

You can convert 401X formats created in DS Windows, for use in Advance. These are 
saved as Advance projects.

You can create a 401X format from a flexible chart in Advance for use in DS Windows.
You can create 401X formats with symbolic series and save them as global formats - 
GXXX. You can use these Global formats in DS Windows and in the Advance 
Datastream 401X format comparison tool.

To convert a 401X format to an Advance project:

1 Select Convert 401X formats from the Tools menu.
The flexible chart format conversion screen is displayed.

2 Search for the formats you want to convert.
You can search User or Global formats.

3 Click the Add button to select a format for conversion.
You can select as many as you want.

4 Click the Selected items button to display the formats selected.
You can remove formats at this stage; click the Remove button.

5 Click the Download button to convert your format.
The Save as dialog is displayed.

6 Select a folder in the Save in: field, type the name in the File name field, and click 
Save.

7 Close the flexible chart format conversion screen to return to Advance.

To view converted 401X formats:

1 Select Open from the File menu.
2 Select the project you saved the format as and click Open.
3 Click the Update Request or Update Project button or double click in the display 

area to update the request.
4 The results are displayed.

Click Settings to edit the flexible chart properties. 

To create a 401X format in Advance:

1 With your flexible chart displayed, right click on flexible chart (in the comparison 
window) and select Create 401X format from this chart from the menu.

2 Type a name in the Format title field.
3 Type a format code, optional. If you choose not to, a code is created for you.
4 Click OK.
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Creating a 401X format with symbolic series

You can create 401X formats with symbolic series and save them as global formats - 
GXXX. You can use these Global formats in DS Windows and in the Advance 
Datastream 401X format comparison tool.

To create a 401X format with symbolic series (X, Y, Z, and A):

1 Select the Comparison tab.
2 Select the Flexible Chart tool from the list displayed.
3 Select Local lists from the Category drop down box.
4 Select a list (any list will do). 
5 Click the Add Series button to add the selected list to the comparison request list.

Repeat steps 3 to 5 for each variable, ie add the list once for one variable, X, or 
four times for four variables, X, Y, Z, and A. 

6 Click the Run Now button.
7 Right click in the Comparison tab window and select Create 401X format from 

this chart from the menu.
8 Type a name in the Format title field.
9 Click OK.

A dialog is displayed giving the GXXX number for the format.

To use a 401X format with symbolic series in Advance:

1 Select the Comparison tab.
2 Select the Datastream 401X format tool from the list displayed.
3 Select the series and add them to the comparison request list.
4 Click the settings button. Type the global format number, or click the Series 

navigation button to search for and select one in navigator.
5 Click the Run Now button.

The results are displayed.

You can now transfer the results to Word, PowerPoint, or Excel as refreshable objects. 
These are updated when opened, reflecting any changes to the Global format.

Excluded options for converted 401X formats

Symbolic series

When a 401X format uses the symbolic series X, Y, Z, or A, these symbolic series will 
be replaced with actual series codes, as Advance flexible charts do not support the 
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use of symbolic substitution.

The series used for substitution will be taken from those stored in Advance. These can 
be viewed or changed via the Tools>Options dialog.

Less frequently used 401X options

Some less frequently used 401X options are not supported in the conversion. Where 
an option is not supported, a similar one is used in its place. The following list shows 
the options excluded and their substitutions:

� LGL Option (Logarithmic scale on left hand Y axis, linear scale on right hand Y 
axis) changed to LOG (Logarithmic scale on both Y axes) 

� LGR Option (Logarithmic scale on right hand Y axis, linear scale on left hand Y 
axis) changed to LIN (Linear scale on both Y axes)

� XAX(n) Option (Grid lines parallel to X axis, drawn against the n-th Y axis label) 
changed to XAXS (Grid lines parallel to the X axis, drawn against every Y axis 
label) 

� LAX(n) Option (Grid lines parallel to Y axis, drawn against the n-th X axis label) 
changed to XAXS (Grid lines parallel to the Y axis, drawn against every X axis 
label) 

� XAI(n) Option (Grid lines parallel to the X axis, drawn against the n-th Y axis label, 
with intermediate lines being drawn between each grid line) changed to XAI (Grid 
lines parallel to the X axis with intermediate lines being drawn between each grid 
line)

� YAI(n) Option (Grid lines parallel to the Y axis, drawn against the n-th X axis label, 
with intermediate lines being drawn between each grid line) changed to YAXS 
(Grid lines drawn parallel to the Y axis, drawn against every X axis label)

� BI(n1n2) Option (Grid lines drawn against both axes, with X axis grid lines being 
drawn against every n1-th X axis label, and Y axis grid lines being drawn against 
every n2-th Y axis label, with intermediate grid lines being drawn between each 
grid line) changed to BOTH (Grid lines drawn against both axes, drawn against 
every axis label)

� BT(n1n2) Option (Grid lines drawn against both axes, with X axis grid lines being 
drawn against every n1-th X axis label, and Y axis grid lines being drawn against 
every n2-th Y axis label) changed to BOTH (Grid lines drawn against both axes, 
drawn against every axis label)

� HLL(n) Option ('Data Displayed' option). Advance flexible charts will only display 
High/Low/Last information for the first series in a flexible chart, the option HLL1 
will be used. 

� NO,FULL,WILO,QILO Options ('Data Displayed' options). Changed to HLL1 if the 
chart would normally have displayed High/Low/Last information at the foot of the 
display, or NHLL if High/Low/Last information would not have been displayed.
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Using Projects

About Projects

Projects are a simple and convenient way of managing requests and recalling 
frequently used reports, charts, and data formats. A Project could, for example, be 
used to contain a number of report and chart requests on each currency within a 
client’s portfolio, or sector of interest.

Once you have created a Project, it can be refreshed on a one-off basis using a 
refresh button, or scheduled to be refreshed overnight using Night Shift, see Schedule 
Night Shift, page 98.

You can:
� Create new Projects, open and save existing Projects using buttons on the tool 

bar.

� Refresh one request, or all requests using the refresh buttons.

� Adjust the column widths in the Project list area to view additional Project details.
� View the display details e.g. start date, data type, for each request using the scroll 

bar.

� Organize your Project requests by selecting a sort category, and by keeping Local 
Lists and Constituent requests together.

� Find specific requests, in your Project list, using the Find: field
� View your report, chart, and data results for a Project in the display area and 

adjust the area for better viewing.
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Selecting a request

To select a request for viewing or updating:

� Select the request description line. 
The Keep Lists Together option on the Project screen displays all individual 
series requests together with their Local List and Constituent List requests. 

Search

� You can identify the required request by using Find: and Sort. Either, type the first 
few letters of the request description, or choose a sort category (for example, 
Description, Analysis tool, and so on).

� You can also use the Goto function (by right-clicking in the display area) to display 
all ‘series’ Local List requests for the Project on a separate selection screen.

Editing the description and comment of a request

You can change the description for a request and add a comment for your own 
reference. To do both, uncheck the Keep Lists Together check box, right-click over 
the request description and select:
� Edit Description – to overtype a new description over the default supplied 

description.

� Edit Comment – to type a new, or edit an existing, free text comment.

Press the RETURN key to confirm your changes.

Merging Two Projects

You can merge two projects to create a third project. 

To merge two projects:

1 Select Merge two projects… from the File menu.
The Select the first project to merge dialog is displayed.

2 Select the project and click Open.
The Select the second project to merge dialog is displayed.

3 Select the project and click Open.
The Select the destination project dialog is displayed.

4 Type the project name and click Save.

The new project is opened when the merge is finished.
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Selecting multiple requests

You can export and delete more than one request at a time.

To select multiple requests:

1 Hold down the CTRL key and use the mouse to select the requests you want to 
export or delete.
You must select in the left hand column of the grid.

User defined ordering of projects

You can sort your requests in to an order that is more appropriate or convenient to you.

To re-order your projects:

1 Click the Use User Defined Order box on the Project tab.
2 Select the request you want to move.
3 Click the Up and Down arrows to move the request up or down.

Note:
If the Keep Lists Together box is ticked, you can only move the requests up and down within 
their parent list.
If the Keep Lists Together box is not ticked, you can move the requests anywhere within the 
project.

Editing the Description and Comment fields

You can edit the description and comment fields by selecting the Edit Description 
option on the right mouse click menu.

To edit the Description and Comment fields:

1 Select Edit Description from the right mouse click menu.
The Edit Description dialog is displayed.

2 Type the new description in the field displayed.
3 Click OK.
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Editing the start and end dates used in a project

You can edit the start and end dates of requests in a project. You can select individual 
requests or select multiple requests, see selecting multiple requests.

To edit the start or end dates of a request:

1 Select Edit start date, or Edit end date, from the right click menu.
2 Type the new date.
3 Click OK.
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Using the browse bar

Using the browse bar

You can use the Browse bar, located on the Request screen, to browse through a list 
of existing requests in the current Project for viewing or refreshing.

� The inner arrow buttons step you through the request list, one request at a time. 
The right arrow button steps forward, the left arrow button steps backwards.

� The outer left-hand arrow button jumps to the beginning of the list, and the outer 
right-hand arrow button jumps to the end of the list.

If you select a list ‘title’ request:

The display area shows what the request was for, the tool, and date created. Double-
click in the display area to refresh the whole Local List request.

If you select a series request:

The results of that request are displayed.
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Using favourites

About favourites

The Favourites: drop down box and button, located underneath the chart/report 
selection area on the Request screen, enables you to add, select, store and retrieve 
your favourite chart, report and data requests saving you time searching for the 
required details. Favourites enables you to select and store a chart/report with screen 
and settings parameters (i.e. display period, datatype, currency, etc.) leaving you free 
to select a new series each time you use your stored Favourite.

Your favourite reports, charts and data requests can be given a unique name and held 
in a dropdown list for easy retrieval. When you select a favourite, the appropriate tool 
is highlighted.

Creating a favourite

To create, store, and retrieve a favourite:

1 Select a chart, report, or data request.
2 Select a display period, datatype or currency, if required.
3 Click the Favourites button.
4 Type a description in the dialog displayed, and click OK. If you do not type a 

description, the Favourite will not be saved.
5 Your stored Favourite can now be selected from the Favourites dropdown list 

above the Settings button. 
6 To issue a request:
7 Select a Favourite from the drop down list.
8 Select a series.
9 Click Run Now. 
If you have created a Favourite using the Flexible Chart and Symbolic First Series 
option, you need to supply a new series. See Using symbolic series with flexible chart 
requests, page 87.

To delete a favourite:

1 Select a Favourite from the dropdown list.
2 Press the DELETE key.
3 Click OK on the confirmation dialog to confirm deletion.
Datastream Advance version 4.0, Issue 1 97



Advance User Guide
Scheduling updates

What is Schedule Night Shift?

Advance Night Shift allows you to refresh any number of Projects at a future time and 
on a regular basis. For example, you can choose to have one or all your Projects 
refreshed overnight giving you access to your charts, reports and data the following 
day. You can also use a third party scheduler such as Microsoft Schedule Tasks, which 
does not require Advance to be left running. 

The Schedule Night Shift dialog (above) enables you to specify the time and date to  
refresh the selected Projects. It also enables you to add or remove Projects from the 
schedule. If you want to process the schedule before the next scheduled update, you 
can reset the status of any Projects and process them straight away using the 
Schedule Now option.

Options provided on the Schedule Night Shift dialog:

� Project Settings -  enables you to automatically export, and print, charts and 
reports when they have been refreshed. The export and print options can be 
applied to individual Projects in your schedule list. See Scheduling Projects and 
Project Settings, page 99.

� Schedule Specials - enables you to schedule equity search formats (that have 
been flagged) for refreshing. This can be scheduled independently of the 
Schedule Project facility. See Scheduling Equity Search Formats and Series 
Coverage Update, page 101.

This is a Project 
that has been 
scheduled to be 
refreshed with its 
status at NOT 
DONE.

The details here show 
what additional export 
and printing options 
have been set up for 
the scheduled Project 
refresh.
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Scheduling Projects and Project Settings

You can schedule Projects for future refreshing and apply print and export settings. If 
you want to refresh Projects straight away, click the Schedule Now option button and 
ignore steps 2 and 3. You can also use a third party scheduler.

To schedule Projects for future over night refreshing:

1 Select the Schedule Night Shift... option from the Tools menu.
2 Click the Schedule For Future option (the date parameters become available).
3 Use the Date and Time options and the Frequency dropdown list to select a:

• date - click on the day, month, and year box in turn to specify a date, 
alternatively use the dropdown calendar (to the right of the date options) to 
select a specific calendar date.

• time - click on the hour and minute box in turn to specify a time.
• frequency - choose a frequency type (daily, weekly, etc.) from the Frequency 

dropdown list.
4 Click the Project Settings tab to select print and export options, if required.

The options displayed on this dialog enable you to:
• Print all requests after updating
• Export all requests after updating
• Choose the desired export format for both charts and reports, which can be:

Reports:
.XLS - for importing into Excel 
.PRN - for producing space delimited files for file printing
.TXT - for producing tab delimited files for import into other packages such as 
spreadsheets
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.CSV - for producing comma separated output for importing into other 
packages
.HTM - for publishing on a Web site

Charts:
.CGM - for exporting to common Windows applications
.EPS – for producing postscript files for high definition graphics printing
.GIF – for displaying graphics in Web sites
.PCX – for use with PC Paintbrush
.WMF – for exporting a chart in the Windows clipboard format

• Select either a symbolic or title file name for the export file. The Symbolic file 
name option creates file names that are in the form aammyynn where aa are 
ascending alphabetic characters, mm is the current month, yy is the current 
year, and nn are sequential numbers. The Title file name option takes the 
names of the series in the request to produce a file name. These options are 
only available when you select Export after processing.

Note:
You have to select the Print and Export options first, and then add the project to the Schedule 
Details list. The Schedule Details list has Print and Export on the details line next to the project. 

• Select the Graph print/ export scheme. The styles you set up and save in 
the properties dialog can be applied to projects scheduled for night shift.

5 Click the Schedule Project tab, if you have done step 4.
6 Build your schedule list by repeating the following steps for each Project you wish 

to add to the schedule:
• Click the Browse button to display a list of your Projects.
• Select a Project.

Tip: If you want to select a number of Projects for your schedule, click the left-hand 
mouse button and drag the cursor over the required Projects.

• Click OK to confirm Project selection
• Click the Add (+) button to add the Project to the Schedule Details list.

7 Repeat steps 4 to 5 for every Project that you want to schedule.
8 Click OK to schedule the refresh of your Projects, with any additional printing, 

exporting options you have selected.

Tip:
The Schedule Night Shift display window shows the Projects, the date they are due for update, 
and their current status (done and not done) for the schedule you have just compiled. If you want 
to view the details for other schedules, click the History button to display a complete history log 
of all past scheduled refreshes.
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Scheduling Equity Search Formats

You can schedule equity search formats for future, out-of-hours processing. If you 
want to run equity search refresh and/or series coverage update straight away, select 
the Schedule Now option and ignore steps 3 and 4 below.

To schedule equity search refresh:

1 Select the Schedule Night Shift... option from the Tools menu.
2 Click the Schedule Specials tab.
3 Click the Schedule For Future option (the date parameters now become 

available).
4 Use the Date and Time options and the Frequency dropdown list to select a:

• date - click on the day, month and year box in turn to specify a date, 
alternatively use the dropdown calendar (to the right of the date options) to 
select a specific calendar date.

• time - click on the hour and minute box in turn to specify a time.
• frequency - choose a frequency type (daily, weekly, etc.) from the Frequency 

dropdown list.

5 Click Refreshable Equity Searches in the Schedule Type window and click the 
Add (+) button, if required.

6 Click OK to schedule your ‘specials’.
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Using equity search

Why use equity search?

Equity search enables you to search across markets for equities that meet a wide 
range of criteria. The equities are displayed in a list in the form of an on-screen report 
together with the your chosen criteria. You can use this data to make comparative 
analysis between equities in markets or lists on key datatypes. You can store the 
search criteria as search requests to carry out future searches and produce updated 
lists.

Equity search enables you to:

� Search for equities in up to 10 specific markets, industry groups, or user created 
lists.

� Search for the equities using up to 10 dedicated Datastream, Worldscope, MCSI, 
I/B/E/S, or Datastream company accounts search items.

� Include Datastream global expressions or your own user created expressions as 
10 search criteria.

� Impose limitations on the search items/datatypes used and determine the units of 
value and currency displayed.

� Set sort criteria on key datatypes.

� Create lists from the results for use with your Local List requests.
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Equity Search – Business Examples

To illustrate the possible business uses of Equity Search, the following four examples 
have been chosen to show the breadth and flexibility of the facility.

Ranking of stocks in a market on a key datatype

With Equity Search you can quickly display lists of stocks in any chosen market 
ranked according to a key datatype with an imposed limitation. The resulting list can be 
saved as a Local List and used with the available chart and report requests to aid your 
research. For example, you could search for a number of stocks on market value, save 
the resulting list, and issue a Price and Price Relative request against each stock in 
the Local List.
This example lists the top 100 equities in the French market by market value, ranked in 
descending market value order with values displayed in French Francs.

� 100 stocks out of the French market are displayed in descending market value 
order. The currency is displayed on screen to aid interpretation. You could further 
refine this list by increasing or decreasing the market value limit.

� You can display up to 10 datatypes across the report. Each of these could have a 
limitation imposed, if required. For example, the search criteria could be amended 
to display all stocks under FF50,000 M. This would exclude the top company in 
this list.
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Global sector comparison on sales

Another powerful feature of Equity Search is its ability to compare sector information 
across broad geographical areas. This can be particularly useful if you want to analyse 
the market presence of companies in specific market sectors in a number of countries.

In this example, the total sales of leading chemical industries are broken down by 
geographical areas, which include Europe, Americas, Asia, Australasia, and Africa. 
Chemical companies are selected from these countries only where their total sales for 
the latest company accounts are over £10M. The companies are listed in descending 
total sales order. The fast search item used in this example is 104 (total sales).

� The results of the search show 246 chemical companies, out of a total of 15,057 
for the global sector, that have total global sales exceeding £10 million. This 
example shows the first 10 companies in ascending alphabetical order. You can 
choose to display these sales values in whichever currency or unit you like.

� You could refine this list, for example by increasing the total sales amount, say to 
£100M and add further related industry sectors such as Chemicals, Speciality and 
Chemicals, Technology.

The results of the 
search show 246 
chemical companies, 
out of a total of 
15,057 for the global 
sector, that have 
total global sales 
that exceed £10 
million in total sales. 
This example shows 
the first 10 
companies in 
ascending 
alphabetical order. 
You can choose to 
display these sales 
values in whichever 
currency or unit you 
like.

You could 
refine this list, 
for example by 
increasing the 
total sales 
amount, say 
to £100 M 
and add 
further 
related 
industry 
sectors such 
as Chemicals, 
Speciality and 
Chemicals, 
Technology.
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Third party data comparisons

As well as having access to Datastream fast search equity datatypes and company 
account items, you can also use I/B/E/S, MSCI and Worldscope datatypes with Equity 
Search. You can mix these third party datatypes with Datastream search items to 
cover wider areas of reported data.

In this example, a mix of MSCI monthly EPS and sales data is displayed with I/B/E/ S 
EPS forecast data for the stocks in the UK market. This example shows that Equity 
Search can be used to compare the current EPS performance of selected stocks with 
their projected forecasts for FY0-FY1 and FY1-FY2. 
The MSCI datatypes of MSEPS, MSDPS and MSCPS are displayed (where available) 
for FTSE ALL SHARE stocks whose total sales are over £20M. The resulting matches 
are displayed in alphabetical order.

� You can use a number of dedicated MSCI datatypes, which help to speed up your 
searches. You can use them to interrogate stocks in countries, sectors or lists, as 
shown here. This list of constituents is sorted alphabetically but you could list 
them by a key MSCI datatype, for example DPS Income Statement.

� The I/B/E/S forecast data shows the percentage growth in EPS between now and 
Fiscal Year 1, together with the number of analyst estimates made. The 
percentage growth between FY1 and FY2, and the number of estimates are 
shown off screen. You can use scroll bars to adjust the display area either 
horizontally or vertically.

You can use a 
number of dedicated 
MSCI datatypes 
which help to speed 
up your searches. 
You can use them to 
interrogate stocks 
in countries, sectors 
or lists, as shown 
here. This list of 
constituents is 
sorted 
alphabetically but 
you could list them a 
key MSCI datatype, 
for example DPS 
Income Statement.

The I/B/E/S 
forecast data 
shows the 
percentage 
growth in EPS 
between now and 
Fiscal Year 1, 
together with the 
number of analyst 
estimates made. 
The percentage 
growth between 
FY1 and FY2, and 
the number of 
estimates are 
shown off screen. 
You can use scroll 
bars to adjust 
the display area 
either horizontally 
or vertically.
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Company profitability figures across sectors

With Equity Search you can use Datastream global expressions or your own user 
created expressions to form part of your search criteria. These expressions allow you 
to combine datatypes or company account items with standard functions to produce 
calculated values for each stock selected in the search. For example, the following 
expression calculates the percentage change of earnings growth over one year.

PCH#(X/X(PE),1Y)
Where:
PCH#   is the percentage change function
X/X (PE) applies the earnings datatype for each stock. 

When you select an expression, its description is displayed in the search wizard and in 
the results window.

You can use up to 10 expressions or you can combine them with Datastream 
datatypes to limit your search, as in the example below. This example shows the top 
100 companies in the French market by market value, and percentage change details 
of earnings for each of these companies are sorted in ascending market value order 
within industry sector.
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.

This comparison enables you to view the earnings growth over the past year in 
relation to current market value. You can use any combination of function and 
datatype with an expression by creating your own expression using the Expression 
Builder.

To aid 
interpretation of 
the search 
results, you can 
list the stocks by 
a datatype or 
expression, for 
example, by the 
expression 
Earnings as 
shown here.

In this example, Dassault Aviation has the largest market capitalization yet its 
increase in earnings potential doesn’t match the highest performer over the past year,
Galeries Lafayette, with 51.61% change in price earnings.
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Equity Search - Features

Here is a list of the most useful features of the Equity Search facility. 

Search formats and Local Lists
When you use Equity Search to create new searches, Advance creates two types of 
records each having their own function.
� Search request format

The search request format is a record that contains all the criteria you enter for 
your search. The record can contain:
• Search universe details
• Datatypes, expressions and limitations
• Currency, units and sort details
• Details of a Local List, if one has been created

The search format is identified by a unique Format Code automatically assigned 
by Advance, and by a description that you type in the search wizard. Each time 
you create an equity search request, a search format is created enabling you to 
run the search request again, or modify its details. 

� Local Lists

Equity Search enables you to store the results from your search as a Local List. 
This list is just like any other Local List that you create using the Local Lists 
wizard. It has a unique List Code and description. When you have created the 
list, it is available for use under the Local Lists tab with your Advance chart and 
report requests. The stocks that belong to these lists will remain static, unless you 
refresh the search requests that they belong to. See Equity Search Project below.

Equity Search Project

All your search request formats are stored in a special Project. This helps to keep all 
your formats in one place and enables you to review, edit, and refresh your search 
requests. The Equity Search Project is displayed by clicking the Equity Search tab. 
Details of all existing search requests are listed on the Project screen.
� Format Code – The code of the search request.

� Description – The search request description.

� List Name – The name of the associated Local List.
� Refresh – Determines whether a search request (and its list) can be refreshed.

� List Code – The code of the associated Local List.

� Last Uploaded – The date when the Local List was last uploaded onto 
Datastream.

� Last Updated - The date when the Local List was last refreshed.
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The Project screen enables you to:

� List and search through all the search requests in the Project. For Projects whose 
number of search formats extend beyond the view/selection area, you can use the 
Find: field to locate the search format you require. You can click on the column 
heading tab to select ascending or descending list order. For example, clicking on 
the Description column heading tab once, lists all the search requests by their 
description in ascending alphabetical order. 

� Edit any listed search request. Select the search request and click on the Edit 
Search... button. The equity search wizard is displayed with the current search 
criteria details. You can amend these details in the same way as you create a new 
search. See Using Equity Search, page 102.

� Refresh any search request to update the associated Local List. For example, if 
your search format searches on market index constituents, you can refresh the 
search to select the current market index constituents. Click the Yes option for the 
requests that you want to Refresh. You can refresh requests individually by 
clicking the Refresh Current Request button, or the whole project by clicking the 
Refresh Project button.

Right-mouse clicks

If you move your mouse over the selection window and right click, a number of ‘short 
cut’ options are available to you:
� Refresh Current Search – refreshes the current search request.

� Refresh All Searches – refreshes all search requests that have been set for 
refreshing.

� New Search – opens the search wizard.
� Edit Search – opens the search wizard with the search criteria of the current 

search request.

� Delete Search – deletes the current search request.

� Allow Column & Row Resizing In Search Report – converts the Search Report 
into spreadsheet format where columns and rows can be resized.

� Default Report Column Widths – restores the default column widths.

Search report window

After each successful completion of a search request, the results are displayed in a 
results window adjacent to the Project screen.

� When you select a search request, the resulting number of stocks found are 
displayed as well as the individual criteria that make up your search.
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� If the descriptions of the stocks are too long to view in the search report window, 
you can click on the Allow Column & Row Resizing In Search Report check 
box and move the displayed column cells.

� The number of matches found for each search criteria (up to 10).

� You can right click the mouse in the results window to get Search Refresh, 
Project Refresh, and Delete options.

� Use the splitter bars or maximize button to increase the display area.

Search Wizard

All search and selection criteria, searching, viewing, and list creation is managed in the 
search wizard.

� Search Universe – you can define the universe in which to start your search from 
choosing up to 10 countries, constituents or User Lists.

� Data Items – you can enter up to 10 data items, which can be datatypes or 
company account items selected from Datastream, I/B/E/S, MSCI or Worldscope, 
or expressions.

� Limitations – you can impose limitations on the data items you have selected 
such as selecting an industry sector, entering maximum or minimum percentage 
changes or market values, or a ‘from and to’ range of values or percentages.

� Display Characteristics – you can determine the currency of the display values 
of your search, the unit of the displayed values and sort sequence (e.g., 
alphabetical, ascending, descending or no sort order).

� Search Now! – when you are happy with your search criteria, you can click on the 
Search Now! button to initiate the search on Datastream. Note: if your selection 
criteria generates a list of over 1000 series, the following message is displayed - 
This search has resulted in too many Equities. Please refine your search criteria.

� View Results – the results of your search criteria are displayed in the lists wizard. 
This shows the number of matches that have been found at each selection criteria 
level, the series and any values for each criteria.

� Refine Search – you can decide to alter or add to your selection criteria, if, for 
example, too many matches were found. Clicking the Refine Search... button 
allows you to review your selection criteria and make any amendments.

� Save As List – when you have the number of matches you want, you can save 
the displayed series as a Local List for use from the Local Lists tab. You can edit 
this list with the Lists Wizard, or overwrite the file with the results of a new search.
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Creating a search

To create a search and to save its format and resulting list of stocks, you need to 
progress through a series of steps. The following procedure provides an overview of 
these steps.

1 Start Search - see Starting a search, page 112
Select the Equity Search tab and click the New Search... button

2 Define Universe - see Defining the universe, page 112
Defining the Universe means identifying the countries, market lists, or user lists 
you want to search through. You can select individual country codes, constituent 
lists, or user created lists.

3 Select Datatypes/Limits - see Selecting Datatypes/Limits, page 114
Your selection criteria can be a combination of up to 10 datatypes, company 
account items, or expressions with limits and values imposed on them.

4 Select Industry Sectors - see Selecting Industry Sectors, page 116
You can further refine your search criteria by selecting up to two industry sector 
mnemonics from two selection lists. You can display the stocks by these sectors in 
the results window.

5 Select Display Characteristics - see Selecting the Display Characteristics, 
page116 
You can decide in what order you want the stocks from the search results to be 
displayed. This could be alphabetically, or sorted by a key datatype.

6 View Results/Refine Search - see Viewing the Results/Refine Search, page 116
Equity Search can display up to 1000 stocks and up to 10 datatypes on the results 
screen. If the number is too big, you can refine your search criteria by clicking the 
Refine Search... button.

7 Store List - see Storing the Search Results, page 117
If you are happy with the search results, you can click the Finish button to enter 
your Local List details. You can also choose to upload the list to Datastream, if 
required.
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Starting a Search

Whether you are planning to edit an existing search or create a new search, the 
Equity Search Project screen is your starting point. 

To create a new search:

� Click the New Search... button. 

To edit an existing search request:

� Select the required search request in the Project screen and click the Edit 
Search... button.

In both instances, the Search wizard is displayed.

Defining the Search Universe

The Search wizard provides two ways of searching:
� Country code searching (separate countries or all countries)

� List searching (Datastream constituents or user created lists)

Country code searching

To search through countries, you can select them individually by selecting Countries 
from the dropdown list, or select all countries by clicking the Search By ALL check 
box. You can also use composite country codes such as Africa or Europe to search 
through all countries that belong to these groups. Select the Composite Code option 
and select a country or region from the drop down list. You can also use a combination 
of country code and composite country codes, for example EUR-UK for Europe 
excluding the UK. These can be typed in the Expert Expression field.

Because of the large numbers of equities involved, Datastream has devised a list of 
useful fast search items to speed up the search. You must use at least one of the fast 
search items with a limitation when you are searching through markets using the 
country codes. (Fast search items and limitations are explained in the section that 
follows.) You can search up to 10 countries on up to 10 datatypes (or through all 48 
available countries on up to 10 datatypes using the Search By ALL option).
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List searching

You can search through any type of list including market index constituents, industry 
sector constituents, or your own user created lists. For example you could search 
through:

� An equity list, such as the Nikkei 500 - JAPA500. 
� The Datastream Food Producers industry sector constituents for the USA.

� A Local List that has been uploaded onto Datastream.

To select constituents, use the Filter facility to list the constituent lists by either market 
or currency, or you can list them by typing in a key letter or phrase in the Find: field. 
For user created lists, you can click the Refresh grid button to update the list held on 
Advance.

Note:
For list searching, equity search cannot search more than 2500 equities. A warning message is 
displayed if more than 2500 equities is exceeded. If this happens, reduce the number of lists 
used.
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Selecting Datatypes and Limitations

The main selection criteria are the search items. You can select up to 10 search items. 
A search item is made up of a datatype (or account item) and a limitation that you 
impose upon it. All the following are search items:

Datatypes and account items

Datatypes and account items fall into three categories. Choose one according to what 
you are doing with Equity Search.

� Fast search items

These are Datastream datatypes and company account items compiled to help 
speed up your searches using country codes. When you choose a fast search 
item, the second and all subsequent items are controlled by the results of the fast 
search item. When you select a country code or a composite country code for 
your search environment, you must select at least one fast search item. 

� Extended search items

There are no restrictions with these search items. They can be used together 
restricting each other. Each of the ten search items produces results 
independently of each other. These include equity datatypes, company account 
items, and expressions.

� Expressions

Expressions with a single variable can be used, for example PCH#(X(MV)), which 
calculates the percentage change of market value for stock X. See Using 
expressions and functions, page 46 for some examples. Note, if currency 
conversion is required for the expression, the tilde (~) function must be used in the 
expression; for example, PCH#(X(MV)~£). Similarly, the units applied are the 
standard ones used in Advance – market value in millions and volume in 
thousands.

Limitations

This part of the search item is used to restrict the results of the datatype, company 
account item, or expression selected. For example, a limitation could restrict the 
search range for a datatype to OVER 100 only
Datastream Advance version 4.0, Issue 1 114



Advance User Guide
.

To search for the top 100 equities, use TOP 100. The maximum limitation for TOP and 
BOTTOM is 1000. The maximum for OVER, UNDER, and TO is 4 digits. Use the Units 
dropdown list for large numbers. 

Units of value

If the range of values for your search is likely to be high, use the Units dropdown list to 
keep the displayed number of figures to a readable size. For example a market value 
of $1,540,000 could be expressed as $1.54 M. The options are: thousands, millions, 
billions and trillions.
If you do not specify a unit, the output displays the most digits possible for each 
individual result. Where you have specified a unit, but an individual result is too large, 
the program displays it in the next highest unit with an indicator of the unit (K, M etc.).

Entering datatypes and limitations

Select the datatypes and limitations that form the basis of your selection criteria in the 
search wizard, after you have clicked Next>.

� Find and select your datatype, click the Datatype navigation button to use 
Datastream navigator
The types of search item available are listed in the Datatype dropdown list. These 
include Fast and Extended search items for Datastream, I/B/E/ S, MSCI, and 
Worldscope databases.

� You can specify a Datastream global expression or a user created expression by 
opening the Expression Picker.

� When you have selected your search item, choose your limitation from the 
dropdown list, add a value, and define the units.

� When you have selected the search and its limitations, click the Add button to 
include these details in the search request. Each set of search details you add will 
be combined using the AND operator to reduce the resulting list of stocks.

Limitation/format Description

OVER xxx
UNDERxxx
xxxTOxxx

These options refer to actual datatype values (xxx) which can 
be 0 to 999999 or 5 numeric characters and a decimal point; 
for example 125.25.

TOPxxx
BOTTOMxxx

These options apply to the fast search items only and refer to 
the number of stocks to be reported on. xxx can be 1 to 1000 
or 1 to 99% (the % limitation applies to each individual market 
and not a group).

xx.x Percentage margin; for example, 10.2. The default is 5.0%.
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Selecting Industry Sectors

To further reduce the number of stocks selected, you can select up to two (optional) 
industry sectors from the third wizard screen:

� Click the Industry Mnemonics tab, and select an industry sector from each list.
� Click the Add button to add the industry sectors to your search criteria list.

Selecting the Display Characteristics

As well as selecting the criteria that determine the stocks and information retrieved, 
you can also determine how this information is displayed. Currency and sort order 
options are available from the fourth search wizard, click the Sort Order & Currency 
tab.
� You can choose to sort your stocks by a key search item in either ascending or 

descending order
OR
list them alphabetically. For secondary sorting, you can choose to list them by 
their industry group sector.

� You can choose any display currency for all the stocks listed irrespective of the 
countries included in the search.

Currency 

You can display the output values in any currency. You select a currency from the 
Currency dropdown list. If you do not pick a currency, the default currency is displayed 
for the search item selected.

Sort order

You can specify the order in which the results of the search are displayed. You can 
rank the equities by:

� Alphabetical order.
� Descending or ascending order of one of the datatypes.

Viewing the Results/Refine Search

After you have entered the selection criteria for your search and have entered any 
display options, you can run the search by clicking Search Now!. The user interface 
keeps you informed of any problems with your search criteria, for example 0 Stocks 
Selected. In instances like this, you can click the Refine Search... button on the empty 
results screen to go back and change your search criteria.
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If your search is successful, the search output screen displays the equities found with 
the datatypes you requested on the search results screen. The display can show up to 
1000 individual stocks (displayed vertically) and up to 10 datatypes (displayed 
horizontally). 

You can decide to refine your search by clicking the Refine Search button or save the 
list by clicking the Save As List button.

Storing the Search Results

To store the results of the search as a Local List, click the Save As List button on the 
search results screen to display the final wizard screen. This enables you to:

� Specify the list file. This is the file name of the Local List, which is displayed on the 
Project screen when the list is created. A default file name is supplied, which you 
can rename. The file must have the extension.LLT and is saved in the directory 
specified for lists in Tools>Options>File Locations.

� Type a list description. This is a description that you can use to identify the 
contents of the Local List displayed. It is displayed in the Project window when the 
list is created

� Upload the list onto the Datastream host system for storage and retrieval. This list 
can be downloaded from Datastream at any time using the Download User 
Created Lists option from the Local Lists wizard. If you store your search lists on 
Datastream, the lists will not be refreshed when using the Refresh option on the 
search Project screen.

If you want the Local List to be updated when you re-run the associated search 
request, click the Allow Search List & Result to be refreshed check box, 

To save the search results as a Local List, EITHER:

� Click the Upload button to upload the list onto Datastream, 
OR

� Click the Finish button to create the Local List on Advance. 
This list is associated with the search request and can be refreshed within the 
search Project screen.
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Creating a new search format and Local List

To create a new search format and Local List:

1 Select the Equity Search tab.
2 Click the New Search... button. 

The Search wizard is displayed.
3 Select up to 10 criteria for the search domain from one domain category, this can 

be:
• Country – click the Country codes radio button and select a country, or click 

the Composite Code radio button and select a composite code, e.g., 
Australasia, from the dropdown list, or click the Expert Expression radio button 
and type a simple expression, e.g., EEC - UK

• Constituent – use the Select Filter and Find facilities to select a Constituent 
List

• Lists – scroll through the displayed list of user lists and select a list, or enter a 
list name (e.g. L#FT30) in the entry field provided.

4 Click the Add button after each selection to add the criteria to your search 
domain.

5 Click Next.
6 Select up to 10 search criteria:

Click the Datatypes & Limitations tab to specify datatypes and limitations:
• click the datatype navigation button, select a datatype source from the 

dropdown list, e.g., Worldscope, and select a datatype from the displayed list. 
Select a type of limitation on the datatype (e.g., OVER) from the Limitations 
dropdown list

• type a value that applies to the limitation in the Value field
• select the units that apply to the value (e.g., millions) from the Units dropdown 

list
• click the Add button to add the datatypes and limitations to your search criteria 

list

Click on the Industry Mnemonics tab to specify industry sectors:
• select an industry mnemonic from the 1st list
• select a second industry mnemonic from the 2nd list
• click the Add button to add the industry mnemonics to your search criteria list

Note: You do not need to select all the options available to you. The minimum 
you need to select is one datatype. As a general rule, the more detailed your 
search criteria, the fewer number of matches will be found.

7 Select the Sort Order & Currency tab and select your output characteristics:
• choose a sort order by clicking an appropriate radio button. If you have chosen 

more than one datatype for your search criteria, both Ascending and 
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Descending sort options give you a choice of datatype from their dropdown 
lists; for example, sort in ascending order of market value.

• select a currency from the displayed list. Choosing a currency will display the 
datatype values in that currency irrespective of the countries included in the 
search.

8 Click Search Now! The results window is displayed.
9 Either click Refine Search and go back to step 4 to amend your search details, 

OR
click Save As List to save the resulting equities as a Local List.

10 Ensure that the Store Search Results check box is checked, and enter a list file 
name with the extension .LLT and enter a list description.

11 Either click Upload to transfer the file to Datastream for storage on the host 
system as a User List, 
OR
click Finish to store your new Local List on your PC.

12 Click Finish.
Your list can be accessed from the Local Lists tab for all your chart, report, and 
data format requests.
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Running an existing search and updating its list

To run an existing search and update its list:

1 Click the Equity Search tab. 
All existing search requests are displayed in the Search Project screen.

2 Search and locate the required search request using the Find: facility.
3 Click the Yes option for the search request under the column Refresh.
4 Click the Refresh Request button on the tool bar to refresh the list. 

During the refresh process, Advance keeps you informed of progress. The 
message Refreshing Search... is displayed, changing to Retrieving List. When 
this message disappears, the list is refreshed. The column Last Updated on the 
Project screen displays today’s date for the list you have just refreshed.
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Amending a search format

To amend a search format:

1 Click the Equity Search tab. 
All existing search requests are displayed in the Search Project screen.

2 Search and locate the required search request using the Find: facility.
3 Select the search request and click the Edit Search... button. The Search wizard 

is displayed with your current search details.
4 Follow steps 4 to 10 in Creating a new search format and Local List, page 118
5 Click Finish to overwrite the existing details with your amendments, 

OR
type a new list file name and description, and click Finish to create a new Local 
List.
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Using the Web Browser

The Web Browser

The web browser displays the Datastream extranet site, First Call Analyst, and 
Thomson Markets.com.

The tool bar contains the following tools:

Back
Takes you back to the last page displayed

Forward
Takes you forward towards the current page

Cancel
Cancels the request

AutoPrint
Prints each page in the browser at the current time. For example, if you have 
a report of 10 pages, Autoprint sends all 10 pages to the printer

Home.
Opens the home page

Address field
The web address of the current page is displayed here. You can type another address 
and press ENTER to go to the address of your choice.
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Using First Call Analyst and Datastream
Advance

In addition to the retrieval of data from Datastream’s own research databases and third 
party databases such I/B/E/S, MSCI, FT/S&P and Worldscope, Advance provides a 
link toThomsons’s web-based First Call Analyst data service. 

Note:
This requires Microsoft Internet Explorer 4.0 (or later) installed on the PC that is running Advance 
4.0 and Adobe Acrobat.3.00 (or later) to view PDF images.
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Using Thomson Markets

Thomson Markets and Datastream Advance

Thomson Markets provides a personal view of global real-time exchanges and news 
integrated with premium historical and fundamental market data at a cost-effective 
price.

Browser-based and accessible via the Internet or through Thomson's own network, 
exchange and contributed prices are combined with a wealth of supporting information 
to provide a portable, integrated and up-to-the-second view of the world's financial 
markets.  

Sourcing content from such industry leading brands as Datastream, Worldscope and 
Dow Jones, Thomson Markets also offers as standard an Excel data transfer facility, 5 
years accounts summary, 390 day news archive, 10 year price chart history and over 
30 technical studies - all delivered in a clear, customisable and easily navigable front-
end.
Datastream Advance's embedded browser supports auto-login and contextual links to 
Thomson Markets.

Configuring Advance to launch Thomson Markets 

You must enable the Browser option on the Advance Options dialog before you can 
launch Thomson Markets within Advance. You can also select the Thomson Markets 
auto login facility on this screen. To use this facility, you must type a valid User Name 
and Password. Contact your Thomson Customer Support Executive for further details.

To configure your Thomson Markets Connection:

1 Select Options from the Tools menu.
2 Select the Internet tab.
3 Click the Web Browser Enabled check box; this enables Advance to launch your 

default web browser.
4 Type the URL in the Server URL: field, ie http://www.thomsonmarkets.com 
5 To use the Thomson Markets auto login facility, click the Auto Login Enabled 

check box and type your User Name and Password in the fields provided.
6 Click OK to configure your Thomson Markets connection.

You can launch Thomson Markets from Advance by clicking the web browser drop 
down list and selecting Thomson Markets.
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Making Thomson Markets requests

To request a Thomson Markets overview:

1 Select the Overview tab from the type of chart or report tabs.
2 Select the required Thomson Markets overview from the Overview list.
3 Select a series from the series display grid using the Find: field. or the Filter 

facility.
4 Click Run Now to issue the request.
5 If you have not configured the Auto Login facility, you are now prompted to supply 

you Thomson Markets User Name and Password. 
6 If your login was successful and the selected series was found on the Thomson 

Markets server, the short quote screen for the selected equity is displayed. 
7 If Thomson Markets could not find the requested series, the Advance Code 

Search dialog is displayed.
This dialog enables you to search for the required series by typing the company 
name. Click Search to display a list of matches. Click on the required company 
hyperlink to display the report required. This dialog can be accessed from 
Company Search in the overviews list box.

Thomson Markets coverage

International exchange and contributed data for a range of financial instruments 
including:
� Equities and equity derivatives

� Sector and market indices

� Exchange traded derivatives
� Foreign exchange and money markets

� Corporate and government bonds

Data is dynamically updated and can be permissioned for either real-time or delayed 
(subject to exchange fees).
Real-time and archived international and national news, filtered and categorised for 
ready retrieval. Standard service includes sources such as Dow Jones and AFX plus a 
range of regulatory and disclosure wires. Additionally, Thomson Markets offers access 
to a number of premium international, national and local-language services.
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Using the extranet

Configuring Advance to launch the Datastream extranet

You can access the Datastream Research Service extranet site in Advance. You can 
configure Advance to automatically display the site on start up.

To register for extranet access

1 Fill out the registration form at http://www.datastream.com/registration/
registfm.htm.

2 Type the Datastream Logon ID that you use for Advance in the Datastream 
Logon ID field.

3 Datastream will email you a User Name and Password for the extranet. Please 
allow 2-3 days.

To access the extranet in Advance:

1 Select Options from the Tools menu.
The Advance Options dialog is displayed.

2 Click the Internet tab.
3 Click the Web Browser Enabled check box; this enables Advance to launch your 

default web browser.
4 Click OK.
5 Click the Datastream.com button on the Advance tool bar.

The Enter Network Password dialog is displayed.
6 Type your User Name and Password and click OK.

To display the extranet when you open Advance:

1 Select Options from the Tools menu.
The Advance Options dialog is displayed.

2 Click the Internet tab.
3 Click the Show on startup check box in the Extranet Options section.
4 Click OK.

The extranet is now shown in the Request window when you open Advance.
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Using Settings
Some reports charts and data format requests can be customised with additional data 
refinements and layout settings. The setttings are made on dialogs, displayed when 
you click the Settings button.

Overview settings

Overview of a company performance

This Overview chart plots the market price of an equity, equity list constituents, or 
Local Lists, together with its price relative to an index. Settings enables you to select 
the relative index. The settings facility gives you two options: 
� Select default relative index

Datastream selects the relative index. You choose the type (market or sector) and 
level of default indices (e.g. level 4), and Datastream chooses the actual relative 
index based upon the series you select.

� Select a specific relative index
You can search through a complete list of Datastream and industry standard 
indices to select the relative index. Use Navigator to speed up your search.

To specify additional settings:

1 Select an appropriate data category and series.
2 Select the Overview tab.
3 Select Overview of a company performance.
4 Click the Settings button.
5 Choose one of the following index options:

• For a default index
- click the Default Index tab
- click either the market or sector option
- select the required default market or sector index type

• For a specific index
- click the Relative Index tab
- use Navigator to narrow down your search
- select the required index

6 Click OK.
You can now make your overview request.
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Chart settings

Candlestick chart

This chart shows the highest, lowest, opening, and closing prices of a series in a 
format similar to a bar-chart known as the `candlestick’. The top of the body of the 
candlestick is the opening or closing price, whichever is greater. The bottom of the 
body of the candlestick is the opening or closing price, whichever is less. The body of 
the candlestick is filled in when the closing price is lower than the opening price, 
otherwise it is left open. The end points of the central line running through the 
candlestick, known as the upper and lower shadow, represent the highest and lowest 
price.

The Candlestick (Keisen) chart is only produced for series where high, low, open, and 
closing prices are available.

You can:
� Determine the frequency of the price bars. For example, they can represent daily, 

weekly, monthly, quarterly, or yearly prices.

� Determine the type of plot scale, linear scale or logarithmic scale

See the Advance Reference guide, Advance Tools Catalogue, page 19,  for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.
These settings are made on the Candlestick Chart settings dialog.

To specify additional settings for the Candlestick Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Candlestick Chart from the selection list.
4 Click the Settings button.
5 Select a plotting frequency by dragging the slider to the required frequency.
6 Click either the Linear or Logarithmic option buttons.
7 Click OK to confirm your additional settings.

You can now make your chart request.
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Line Chart

This chart plots values for individually selected securities and associated datatypes 
over a user-defined display period.

See the Advance Reference guide, Advance Tools Catalogue, page 19, for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.
You can determine the type of scale plot:

� Linear scale

� Logarithmic scale
These additional settings are made on the Line Chart settings dialog.

Note:
The Frequency option is not available, but is available for Price High/Low/Close, Price and 
Volume, Candlestick, Trend Analysis Charts and Time Series Data. The Display Options are only 
available for Time Series Data requests.

To specify additional settings for the Line Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Line Chart from the selection list.
4 Click the Settings button.
5 Click either the Linear or Logarithmic option buttons.
6 Click OK to confirm your additional settings.
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Moving Average Chart 5 - 20 days

The Moving Average 5 – 20 days chart allows you to plot the 5 day and 20 day moving 
average of a stock or series over a specified period of time. A moving average line plot 
is produced by calculating the average over a 5 and 20 day period over the display 
period you select.

You can determine the type of scale plot:
� Linear scale

� Logarithmic scale

Note:
The Frequency option is not available, but is available for Price High/Low/Close, Price and 
Volume, Candlestick, Trend Analysis Charts and Time Series Data. The Display Options are only 
available for Time Series Data requests.

To specify additional settings for the Percentage Changes Chart:

1 Select the data category and series.
2 Select the Chart tab.
3 Select Moving Average Chart 5 – 20 days from the selection list.
4 Click the Settings button.
5 Click either the Linear or Logarithmic option buttons.
6 Click OK to confirm your additional settings.
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Moving Average Chart - Configurable

This chart plots a security, series, or expression together with up to two moving 
averages and an optional momentum chart. This chart is similar to the Moving 
Average Chart (5 and 20) except you can specify any value and frequency for the two 
moving averages. You can also specify:

� Y axis based upon logarithmic or linear scale
� Momentum can be based on either the difference or ratio of two defined moving 

averages.

The Moving Average Chart - Configurable can be produced for all data categories 
except Economic reports/charts. 

When selecting the moving average period frequency, you must match the plot 
frequency with the frequency of data you are plotting. For example, company accounts 
data must be plotted in multiples of years as the data is collected on a yearly basis.
The displayed plotting frequency is determined by the chosen display period, which is 
daily up to two years, weekly between two and 10 years, and monthly over 10 years. 
For example, a moving average period frequency of 91 days for a display period over 
two years will be converted into an equivalent period of 18 weeks.

All settings are made on the Moving Average Chart - Configurable settings dialog.

To select additional settings:

1 Select a data category and series.
2 Click the Chart tab.
3 Select Moving Average Chart - Configurable from the selection list.
4 Click the Settings button.
5 Type a value and select a frequency for the first moving average period.
6 Type a value and select a frequency for the second moving average period, if 

required.
7 Select the Y Scale Linear or Y Scale Logarithmic option.
8 Select a momentum option (Ratio or Difference) or the Suppress momentum 

option.
9 Click OK to save your chart settings.

You can now issue your chart request with your additional settings.
Datastream Advance version 4.0, Issue 1 131



Advance User Guide
PE Bands Chart

The PE Bands Chart is used to compare a share price, price index or investment trust 
with a fundamental datatype, such as its earnings per share over time. The chart plots 
the historical price overlaid with bands, which are multiples of the selected series and/ 
or datatype. Typically multiples are entered so that the top band passes through the 
high price and the bottom band passes through the low price.

You select the series for the historical price plot and display period on the main 
Request screen. Settings lets you to make the following additional settings:
� Series and/or datatype for the PE bands. For datatypes, you can choose from 

Datastream, I/B/E/S, MSCI and Datastream company accounts datatypes

� Up to 6 PE bands with user specified multiples for each band

� Plot frequencies for both series/datatype and PE bands
� User defined Y axis range

� Choose from three grid styles

� Optional Volume chart can be produced in addition to PE Bands Chart
These additional settings are made on the PE Bands Chart dialog. If settings are not 
made, default values are assumed.

To specify additional settings for the PE Bands Chart:

1 Select an equity, index or constituent series.
2 Select the PE Bands Chart from the Chart tab.
3 Select a display period for the chart. 
4 Click the Settings button.
5 Select the datatype or series and datatype for the bands:

• For series and datatype selection:
��select the Series tab
��search for a series using Navigator
��click a series to select it, the name appears in the Series display field
��search for a datatype using Navigator
��click a datatype to select it, the name appears in the Datatype display 

field
6 Select a series plot frequency by moving the Series Frequency slider.
7 Select a band plot by moving the Band Frequency slider.
8 Select the Multiples tab.
9 Select the number of bands required by using Number of Bands spin buttons.
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10 For each band, type the multiple number in each band field. Use the TAB key to 
move the cursor from field to field.

11 Choose either a Linear or Logarithmic scale for the line plot by clicking the 
appropriate radio button.

12 Type the From and To scale ranges for the Y axis, if required. If left blank, an 
appropriate scale is automatically assigned.

13 Select a grid style by clicking the style button, if required.
14 Click the Volume Chart Required check box, if the additional chart is required.
15 Click OK.

These settings remain in use for each request you issue until they are changed. You 
can have different settings for each PE Band Chart request you issue.
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Percentage Changes Chart

The Percentage Changes Chart lets you to plot the percentage change of a stock or 
series over a specified period of time. A percentage change line plot is produced by 
comparing the price/value of a series now with the price/value n days or months ago, 
and then rolled back over the display period you select. The n value is set to a year 
and the plotting frequency, printed in the title, is determined by Datastream.

See the Advance Reference guide, Advance Tools Catalogue, page 19, for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.
By clicking the Settings button, you can determine the type of scale plot:

� Linear scale

� Logarithmic scale
These additional settings are made on the Percentage Change Chart settings dialog.

Note:
The Frequency option is not available, but is available for Price High/Low/Close, Price and 
Volume, Candlestick, Trend Analysis Charts and Time Series Data. The Display Options are only 
available for Time Series Data requests.

To specify additional settings for the Percentage Changes Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Percentage Changes Chart from the selection list.
4 Click the Settings button.
5 Click either the Linear or Logarithmic option.
6 Click OK to confirm your additional settings.
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Point & Figure Chart

This chart plots the price rise and fall for a selected series and date range. Unlike most 
price charts, the Point and Figure chart abandons the use of the X axis for plotting the 
passage of time and plots price change on both the Y and X axis.

Point and Figure charts display an X when prices rise by the box size, and display an 
O when prices fall by the box size. Each column contains either Xs or Os but never 
both. For a price to change column, for example an X column to an O column, the 
price must reverse by the reversal amount multiplied by the box size. The box size and 
the reversal amount are both displayed on the chart.
You can:

� Type a title

� Select the number and size of the boxes

 

These settings are made on the Point &Figure Chart settings dialog.

To specify additional settings for the Point &Figure Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Point &Figure Chart from the selection list.
4 Click the Settings button.
5 Type a title in the Chart Title: field.
6 Select the Number of boxes for a Reversal.
7 Select the Size of Boxes.
8 Click OK to confirm your additional settings.

You can now make your chart request.
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Price High/Low/Close Chart

The Price High/Low/Close Chart allows you to produce price bars, showing the 
highest, lowest and closing prices, for a selected series over a user defined display 
period. Settings lets you:

� Determine how often the price bars are plotted, for example they can represent 
daily, weekly, monthly, quarterly or yearly prices.

� Change the type of plot scale used from a linear scale to a logarithmic scale

See the Advance Reference guide, Advance Tools Catalogue, page 19, for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.

These additional settings are made on the Price High/Low/Close Chart settings 
screen:

Note:
The Display Options are only available for Time Series Data requests.

To specify additional settings for the Price High/Low/Close Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Price High/Low/Close Chart from the selection list.
4 Click the Settings button.
5 Choose a plotting frequency by dragging the slider to select the required 

frequency.
6 Click on either the Linear or Logarithmic radio buttons.
7 Click OK to confirm your additional settings.

You can now issue your chart request.
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Price & Index Relative Chart

The Price and Index Relative chart is a composite graph showing price performance 
details for a selected equity series, constituent list, or Local List on two charts. The first 
chart is a simple line chart plotting the price of the selected equity over a user specified 
display period. The second chart plots the series price divided by a default price index 
rebased to an opening index value of 100. A line is drawn across the chart at 100 to 
aid interpretation.

The settings facility gives you two options for selecting Y. 
� Select default index

This option allows you to leave the decision on what relative index to use to 
Datastream. You choose the type (market or sector) and level of default indices 
(e.g. level 4), and Datastream chooses the actual relative index based upon the 
series you select.

� Select a specific relative index
You can search through a complete list of Datastream and industry standard 
indices to select the relative index. Navigator is located on the settings screen to 
help you speed up your search through the series database.

To specify additional settings:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select the Price & Index Relative Chart.
4 Click the Settings button.
5 Choose one of the following index options:

• For an individual index
��click the Relative Index tab
��use Navigator to find your series
��select the required indices

• For a default index
��click the Default Index tab
��click either the Market or Sector option
��select the required default market or sector index type

6 Choose either the Linear or Logarithmic scale for the Y axis by clicking the 
appropriate option.

7 Click OK to save your chart settings.

You can now make your chart request.
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Price and Price Relative Chart

This Price and Price Relative chart plots the market price of an equity (or equity list 
constituents), unit trust or investment trust together with its price relative to an index. It 
can also be used to compare an equity against another market index. Settings 
enables you to select the index that will form the Y element in the following equation:

X / Y * 100
where X can be an equity price or price index. Settings gives you two options for 
selecting Y. 

� Select a specific relative index
You can search through a complete list of Datastream and industry standard 
indices to select the relative index. Navigator is located on the settings screen to 
help you find your series.

� Select default index
This option allows you to leave the decision on what relative index to use to 
Datastream. You choose the type (market or sector) and level of default indices 
(e.g. level 4), and Datastream chooses the actual relative index based upon the 
series you select.

To specify additional settings:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select the Price and Price Relative Chart.
4 Click the Settings button.
5 Choose one of the following index options:

• For an individual index:
��click the Relative Index tab
��use Navigator to find your index
��select the required indices

• For a default index
��click the Default Index tab
��click either the Market or Sector options
��select the required default market or sector index type

6 Choose either the Linear or Logarithmic scale for the Y axis by clicking the 
appropriate option button (not available for Performance over 1, 3 and 12 months 
report).

7 Click OK to save your chart settings.
You can now issue your chart request with your additional settings.
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Price & Volume Chart

This composite graph displays two charts; a line chart plotting the price of a selected 
equity, or Local List, over a user-defined display period, and a separate bar chart 
showing the volume of trade for the same equity within the same display period.

You can:
� Determine the frequency of the price bars. For example, they can represent daily, 

weekly, monthly, quarterly, or yearly prices.

� Determine the type of plot scale, linear scale or logarithmic scale

See the Advance Reference guide, Advance Tools Catalogue, page 19,  for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.
These settings are made on the Price & Volume settings dialog.

To specify additional settings for the Price & Volume Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Price & Volume Chart from the selection list.
4 Click the Settings button.
5 Select a plotting frequency by dragging the slider to the required frequency.
6 Click either the Linear or Logarithmic option buttons.
7 Click OK to confirm your additional settings.

You can now make your chart request.
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Reversal Chart

This chart shows a reversal diagram for a selected series and date range. A reversal 
diagram shows the same information as a Point and Figure Chart, but with the 
information presented more concisely.

Reversal diagrams are plotted without an X axis time scale, but show:
� A price rise represented by a vertical line with a bar on top

� A price fall represented by a vertical line with a bar at the bottom

You can:
� Determine the frequency of the chart. For example, daily, weekly, monthly, 

quarterly, or yearly

� Determine the type of plot scale, linear scale or logarithmic scale

See the Advance Reference guide, Advance Tools Catalogue, page 19, for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.
These settings are made on the Reversal Chart settings dialog.

To specify additional settings for the Reversal Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Reversal Chart from the selection list.
4 Click the Settings button.
5 Select a plotting frequency by dragging the slider to the required frequency.
6 Click either the Linear or Logarithmic option buttons.
7 Click OK to confirm your additional settings.

You can now make your chart request.
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Trend Analysis Chart

This chart generates a forecast of the future performance of a series based upon past 
results. The chart plots the values of the selected series as a simple line chart and 
calculates an additional ‘least squares’ trend line. The coefficients for the trend line are 
calculated such that the A coefficient is the value of the series at the start date, and the 
B coefficient is the series value for each time period (i.e. frequency).

You can:
� Determine the frequency of the chart. For example, daily, weekly, monthly, 

quarterly, or yearly.

� Determine the type of plot scale, linear scale or logarithmic scale

See the Advance Reference guide, Advance Tools Catalogue, page 19, for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.
These settings are made on the Trend Analysis Chart settings dialog.

To specify additional settings for the Trend Analysis Chart:

1 Select an appropriate data category and series.
2 Select the Chart tab.
3 Select Trend Analysis Chart from the selection list.
4 Click the Settings button.
5 Select a plotting frequency by dragging the slider to the required frequency.
6 Click either the Linear or Logarithmic option.
7 Click OK to confirm your additional settings.

You can now make your chart request.
Datastream Advance version 4.0, Issue 1 141



Advance User Guide
Report settings

Actual Values (104) from start date Report

This report displays up to 104 daily, weekly, monthly, quarterly, or yearly price values 
for a selected Datastream series in a calendar format. The highest and lowest price 
values of the reporting period are displayed at the top of the report with their dates.
You can:

� Determine the frequency of the values. For example, they can represent daily, 
weekly, monthly, quarterly, or yearly prices.

See the Advance Reference guide, Advance Tools Catalogue, page 19, for details on 
the display period, datatypes, and currency adjustments you can make for each data 
category.
These settings are made on the Actual Values (104) from start date settings dialog.

To specify additional settings for the Actual Values (104) from start date report:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Actual Values (104) from start date report from the selection list.
4 Click the Settings button.
5 Select a plotting frequency by dragging the slider to the required frequency.
6 Click OK to confirm your additional settings.

You can now make your report request.
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Balance sheet report

This reports displays company balance details for a selected equity series, over the 
last five years. Balances for all major company accounts are displayed which include 
Income accounts, operating profit accounts, cost and expenditure accounts, taxation 
accounts, after tax profit accounts and employment accounts. Balances are grouped 
according to account type and are displayed with account number and description.

You can:
� Choose to display data as:

• Actual values
• Index numbers
• Percentage change
• Per share

� Select the detail level, Detail or Key Items
� Select the Index base year, or relative period

To specify additional settings for the Balance Sheet report:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Balance Sheet report from the selection list.
4 Click the Settings button.
5 Select a display option from the Display Option drop down box.
6 Select the detail level from the Detail Level options.
7 Select the index base year, or relative period.
8 Click OK to confirm your additional settings.

You can now make your report request.
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Capital Issues & Changes report

This report displays a diary of capital events (issues, deletions, consolidations, etc.) 
which directly affect shareholder’s holdings of security. The report specifically gives 
details on the issue of new securities and the replacement of existing shareholders’ 
holdings with different securities.

Each diary event is listed in ascending date order with a description of the event type, 
details of the issue or replacement terms and the dates upon which the shareholder is 
affected. Data is added to the diary as it is received which may result in temporary 
incomplete details. Cancelled events are marked as deletions and are held on the 
diary for at least 24 hours before final removal.

You can:

� Select upto 5 types of issue or changes
� Select an event date

� Select an amendment date

To specify additional settings for the Capital Issues & Changes report:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Capital Issues & Changes Report from the selection list.
4 Click the Settings button.
5 Select up to 5 types of issue or change from the Types of Issue/Change list.
6 Click the Add button to add them to the Selected Issue/Change list.
7 Click the Ex/Event Date: check box to add an event date
8 Click the Amendment date: check box to add an amendment date.
9 Click OK to confirm your additional settings.

You can now make your report request.
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Cash Flow Statement Report

This report displays a cash flow statement for a selected equity series. The report 
shows subtotals of cash flow movements due to adjustments, investing and financing 
activities, change in working capital and return on investments, for each year where 
data is available. Subtotals for cash flow accounts are grouped by account type and 
are displayed with their account number and description.

You can:
� Choose to display data as:

• Actual values
• Index numbers
• Percentage change
• Per share

� Select the detail level, Detail or Key Items
� Select the Index base year, or relative period

To specify additional settings for the Cash Flow Statement report:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Cash Flow Statement report from the selection list.
4 Click the Settings button.
5 Select a display option from the Display Option drop down box.
6 Select the detail level from the Detail Level options.
7 Select the index base year, or relative period.
8 Click OK to confirm your additional settings.

You can now make your report request.
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Performance Over 1, 3 and 12 Months Report

The Performance Over 1, 3 and 12 Months report displays the price on the selected 
date and the % change over the previous month, three months and 12 months for an 
equity series, index, unit trust, investment trust, or a list of these. The constituents of a 
list are displayed in ascending alphabetical order.

Settings enables you to choose one of three additional display options:
� Display the % gains/loss relative to a specific index that you select. This data is 

displayed under three additional columns (one for each % change period) labelled 
%GAINS/LOSS ON INDEX. You can search through a complete list of 
Datastream and industry standard indices to select the relative index. Use 
Navigator to find your index.

� Display the % gains/loss relative to a default index type that you select. This data, 
again, is displayed under three additional columns labelled %GAINS/LOSS ON 
INDEX. This option allows you to leave the decision on what relative index to use 
to Datastream. You choose the type (market or sector) and level of default indices 
(e.g. level 4), and Datastream chooses the actual relative index based upon the 
list you select. 

� Turn off the relative/default index display.
This option enables you to switch off the three additional (optional) columns 
%GAINS/LOSS.

The Settings facility provides one further option which enables you to change the 
three default % change periods (1, 3 and 12 months) to any three periods within a two 
year period. For example you could change the three periods to 6 months, 1 year and 
18 months. These changes are made on the Periods tab, the Index Selection screen.

To specify additional settings:

1 Select an appropriate data category and list.
2 Select the Report tab.
3 Select the Performance Over 1, 3 and 12 Months report.
4 Click the Settings button. The Index Selection screen is displayed.
5 Choose one of the following three index options:

• For a specific index
- ensure the Ignore Index check box is unchecked
- click the Relative Index tab
- click the Series navigation button to use Navigator to find your index

• For a default index
- ensure the Ignore Index check box is unchecked
- click the Default Index tab
- click either the Market or Sector option
- select the required default market or sector index type
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• To turn off the relative index column
- click the Ignore Index check box

6 Click the Period tab and change the default periods, if required.
• use the Period Type dropdown list to select the type of period (day, month 

and so on)
• use the Period up and down buttons to set three new default percentage 

change periods (the Default button returns your new settings back to their 
defaults periods).

7 Click OK to save your report settings

You can now issue your report request with your additional settings.
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Performance Range & Average Report

This report displays start and end values, percentage change, high and low values 
with dates, and an average value for a Datastream series or list of series over a user 
defined time period. You can specify a datatype from those available or generate the 
report using the default datatype for the data category selected. You can produce the 
same results for an expression by using the Performance, range & average using 
expression report.

You can:
� Select a datatype or expression 

� Select a second display date

To specify additional settings for the Performance Range & Average, using 
Expressions, report:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Performance Range & Average, using Expressions, report from the 

selection list.
4 Click the Settings button.
5 Select either the

• Use Datatype as the Expression option,
Select the type of Datatype from the drop down box and select the datatype 
from the list displayed. You can use Navigator to speed up your search.
OR
Use an expression option

6 Select a second display date from the Second display Date boxes.
7 Click OK to confirm your additional settings.

You can now make your report request.
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Performance Range & Average, using Expressions, Report

This report displays start and end values, percentage change, high and low values 
with dates, and an average value for a Datastream expression over a user defined 
time period. You can produce the same results for a Datastream series or list of series 
by using the Performance, range & average report.

You can:

� Select a datatype or expression 

To specify additional settings for the Performance Range & Average, using 
Expressions, report:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Performance Range & Average, using Expressions, report from the 

selection list.
4 Click the Settings button.
5 Select either the

• Use a datatype as the Expression option.
Select a recent Datatype from the drop down box or use Navigator to find 
your datatype.
OR
Use an expression option.
Click the Expressions button and select an expression from the Expression 
picker.

6 Click OK to confirm your additional settings.

You can now make your report request.
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Profit and Loss Report

This report shows profit and loss account information for a selected company, where 
data has been published. The report shows balances for key Profit & Loss accounts 
including trading income accounts, costs and expenditure accounts, operating and 
non-operating profit accounts. Profit & Loss values are grouped by account type and 
are displayed with their account number and description.

You can:
� Choose to display data as:

• Actual values
• Index numbers
• Percentage change
• Per share

� Select the detail level, Detail or Key Items
� Select the Index base year, or relative period

� Include revenue account

To specify additional settings for the Profit and Loss report:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Profit and Loss report from the selection list.
4 Click the Settings button.
5 Select a display option from the Display Option drop down box.
6 Select the detail level from the Detail Level options.
7 Select the index base year, or relative period.
8 Click OK to confirm your additional settings.

You can now make your report request.
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Values over time and % changes for Economics

You can:

� Select monthly, quarterly, or annual frequency
� Select the start and end dates

To specify additional settings for the Values over time and % changes for 
Economics:

1 Select an appropriate data category and series.
2 Select the Comparisons tab.
3 Select Values over time and % changes for Economics from the selection list.
4 Click the Settings button.
5 Select a frequency option.
6 Select the Start and End periods.
7 Click OK to confirm your additional settings.

You can now make your report request.
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Data settings

Company Accounts Data

You can download company accounts data for a selected equity series and user 
defined display period. Company accounts data requests can only be issued for 
Equities and Constituents and Local Lists that contain only equity series.
You can define the type and format of the company accounts data you download from 
Datastream. Click the Settings button to display the Company Accounts Data 
dialog.

You can choose from Global or User created company accounts formats.

Global company accounts formats

� Formats:   Select a format from the list.

� Expert   If you have previously created a company accounts format on 
Datastream, you can type the code in the Expert field and download the data 
directly.

User company accounts formats

� Formats:    Select a format from the list
� Create…    You can create a new list

� Amend…  You can amend an existing format

� Refresh list   You can refresh the list displayed

Annualise

� Click this check box to adjust the company accounts over the display period to 
give you annualised data.
This is for companies who have moved their year end dates, say from end of year 
to mid year.

To download Company Accounts Data with a Global format:

1 Select an appropriate data category and series.
2 Select the Data for a single series tab.
3 Select Company Accounts Data from the selection list.
4 Click the Settings button.
5 Select Global company accounts formats 
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6 Select a format from the list displayed
OR
Type your request code in the Expert field.

7 Click the Annualise check box, if you want annualisation.
8 Click OK.

To download Company accounts data with a User created format:

1 Select an appropriate data category and series.
2 Select the Data for a single series tab.
3 Select Company Accounts Data from the selection list.
4 Click the Settings button.
5 Select User created company accounts formats 
6 Select a format from the list displayed

OR
Click the Create button to create a new format
OR
Click the Amend button to amend an existing format

7 Click the Annualise check box, if you want annualisation.
8 Click OK.
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Static Data

Static data requests download values for a selected series at a particular point in time. 
Settings lets you to define the data you download from Datastream and determine 
how it is labelled. Using Settings, you can select up to 9 datatypes. 

Note:
The datatype NAME is added as the first datatype for each request. NAME provides the title of 
the data series.

The type of datatype you can select is dependent upon the data category chosen. For 
equities, for example, you can select from Datastream, I/B/E/S and MSCI datatypes, 
and Worldscope, and Datastream Company accounts data items.

Use the dropdown list at the top of the Static Data dialog to select the datatype 
source. 
The Expression Picker and Expression Builder facilities are located on this dialog, if 
you want to create or use an existing expression as part of the static data request. See 
About Expressions and Functions, page 46.

To specify additional settings for Static Data:

1 Select an appropriate Data category and Series.
2 Select either the Data or Comparison tab.
3 Select Static Data from the selection list.
4 Click the Settings button.
5 Use Navigator to select your datatypes. Select up to 9 datatypes.

Note: The currency field is disabled if the datatype is not currency convertible.
6 Click the Remember Datatypes check box to store your datatype selections for 

use with Flexible Report requests. As the Flexible Report uses up to five 
datatypes, only the first five datatypes selected for Static Data requests are 
stored.

7 Click the Display Options you want: Titles,Column Headings, Row Headings, 
and Currency.

8 If your static data request is for a Local List, click the Retain List check box. The 
list of datatypes for your request will be retained on the host system so you can 
embed the data request in Excel.

9 Click OK to confirm your additional settings.
You can now issue your data request with your additional settings.
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Time Series Data

The settings available for time series data requests enable you to specify the 
frequency of reported data for the time period selected. The default is daily, however 
you can change this to Weekly, Monthly, Quarterly and Yearly. There is no restriction 
on the amount of data you can display except for a limit of 16,384 rows in the display 
area. So for example, you could display over 10 years worth of daily data.

In addition to the settings for data frequency, you can also select a number of display 
options which include:
� Titles - general headings for row and column titles, for example CODE for series 

and datatype mnemonics.

� Column headings - the datatype mnemonic at the top of each column

� Row headings - the series mnemonic at the head of each row for each series 
selected

� Currency - display an additional column with the title CURRENCY and with the 
traded currency for each selected series.

The selections are made on the Time Series Data settings screen:

The Lin/Log settings are not available for time series data requests. 

To use the Time Series Data settings:

1 Select an appropriate data category and series.
2 Select the Data tab.
3 Select Time Series Data from the selection list.
4 Click the Settings button. The Time Series Data settings dialog is displayed.
5 Choose the data Frequency by dragging the slider to select the required 

frequency.
6 Select the Display Options by clicking the required check boxes.
7 Click OK.
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Summary settings

Bar chart: flexible

This chart is similar in use to the Flexible Report in that it can display data for up to five 
individually selected datatypes, however the results are displayed as horizontal bars. 
The chart is particularly useful for comparing datatypes for a list of series, for example 
in an industry sector (i.e. Datastream Constituent list) or a portfolio (i.e. Local List). 
The DSWindows equivalent tool is 401W.
Values for up to five datatypes can be displayed for each series in a list up to a 
maximum of 60 bars. Datatypes are selected on the tool’s Settings dialog, which 
enable you to:

� Select up to 5 datatypes (including Datastream, I/B/E/S, MSCI datatypes)

� Use datatypes already selected with the Flexible Report and Static Data request’s 
Remember Datatypes facility.

� Type your own chart title and legends for the datatypes selected or use the 
Datastream’s default datatype names.

� Sort the results alphabetically in ascending/descending order or on a key 
datatype.

� Override the default X axis scale range by typing from and to ranges.
The Expression Picker and Expression Builder facilities are located on this screen, if 
you want to create or use an existing expression as part of the bar chart request. See 
Expressions and Functions, page 46 for further details.

To issue a Bar Chart: Flexible request:

1 On the Request screen, select a Local List or a Constituent list from the category 
drop down box.

2 Click the Summary tab.
3 Click the Bar Chart: Flexible tool.
4 Click the Data Selection button and select a Fixed or Relative End Date or select 

Today.
5 Click Settings. 

The settings dialog for the Bar Chart: Flexible tool is displayed.
6 Use Navigator to select your datatypes.
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7 Select up to 5 individual datatypes from Datastream, I/B/E/S, Worldscope, MSCI 
and Datastream Company Accounts datatype sources. Use Navigator to select 
your datatypes. 
Click the Remember Datatypes check box to store your datatype selections for 
use with Static Data and Flexible Report requests.

8 Click on the Sort Order & Axis tab
9 Type a chart title in field Chart Title: if required.
10 Overtype the default legend titles with your own legend titles, if required.
11 Set the X axis From and To range, if required.
12 Increase the default number of displayed bars from 30, if required.
13 Click the Grid Required check box to display the optional grid, if required.
14 Select the required sort order by clicking the Order by List, Order Alphabetically 

or Order by Datatype options. If you select Order by Datatype, you can select 
the datatype from the adjacent picklist and optionally select to display those 
values in ascending order.

15 Click OK to save your settings and close the settings dialog.
16 Click Run Now to issue the Bar Chart: Flexible request.
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Company Accounts Data

You can download company accounts data for a selected equity series and user 
defined display period. Company accounts data requests can only be issued for 
Equities and Constituents and Local Lists that contain only equity series.

You can define the type and format of the company accounts data you download from 
Datastream. Click the Settings button to display the Company Accounts Data 
dialog.
You can choose from Global or User created company accounts formats.

Global company accounts formats

� Formats:   Select a format from the list.

� Expert   If you have previously created a company accounts format on 
Datastream, you can type the code in the Expert field and download the data 
directly.

User company accounts formats

� Formats:    Select a format from the list

� Create…    You can create a new list
� Amend…  You can amend an existing format

� Refresh list   You can refresh the list displayed

Annualise

� Click this check box to adjust the company accounts over the display period to 
give you annualised data.
This is for companies who have moved their year end dates, say from end of year 
to mid year.

To download Company Accounts Data with a Global format:

1 Select an appropriate data category and series.
2 Select the Data for a single series tab.
3 Select Company Accounts Data from the selection list.
4 Click the Settings button.
5 Select Global company accounts formats 
6 Select a format from the list displayed

OR
Type your request code in the Expert field.

7 Click the Annualise check box, if you want annualisation.
8 Click OK.
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To download Company accounts data with a User created format:

1 Select an appropriate data category and series.
2 Select the Data for a single series tab.
3 Select Company Accounts Data from the selection list.
4 Click the Settings button.
5 Select User created company accounts formats 
6 Select a format from the list displayed

OR
Click the Create button to create a new format
OR
Click the Amend button to amend an existing format

7 Click the Annualise check box, if you want annualisation.
8 Click OK.
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Flexible Report

The Flexible Report provides details on datatypes from over 3,500 Datastream and 
industry constituent lists, such as key world business sectors and benchmarks. The 
Settings dialog lets you select up to 5 datatypes for the report, which can be from 
Datastream, I/B/E/S and MSCI datatypes, Worldscope, and Datastream Company 
accounts data items.

In addition to the datatype selections you can make, you can also:
� Store your datatype selections for use with the Static Data request

� Use a primary and secondary sort sequence for any selected datatype

� Choose an alphabetical ascending or descending sequence order
� Type your own report and column titles

See the Advance Reference guide, Advance Tools Catalogue, page 19,  for details on 
the refinements you can make to the Constituents data category for this report.

All settings are entered by using the Flexible Report settings dialog. 
The Expression Picker and Expression Builder facilities are located on this screen, 
if you want to create or use an existing expression as part of the static data request. 
See About Expressions and Functions, page 46 

To specify additional settings for the Flexible Report:

1 Select the Constituents data category and a series.
2 Select Flexible Report from the Summary tab.
3 Click the Settings button.
4 Use Navigator to select a datatype. Select up to 5 datatypes.

Note: The currency field is disabled if the datatype is not currency convertible.
5 Click the Remember Datatypes check box to store your datatype selections for 

use with Static Data requests.
6 Click the Next> button.
7 Click the check boxes of the datatype you want for your primary sort sequence, 

and click on either the ascending or descending alphabetical order buttons.
8 Click the check boxes of the datatype you want for your secondary sort sequence, 

if required, and click on either the ascending or descending alphabetical order 
buttons.

9 Click the Display Options you want: Report Title, Row Titles.
10 Click the Finish button to save your settings.
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Latest Values & % changes over 3 periods Summary

This report displays latest value, high, low, and percent changes over 3 periods for 
Constituents and the constituents of a Local List. Values are displayed in list/series 
order. 

You can:
� Select a function or expression, or build one

� Select 3 periods for the changes

To specify additional settings for the Latest Values & % changes over 3 periods 
Summary:

1 Select an appropriate data category and series.
2 Select the Summary tab.
3 Select Latest Values & % changes over 3 periods Summary from the selection 

list.
4 Click the Settings button.
5 Click the Function button to select a function or expression, or click the 

Expression Builder button to build a new expression.
6 Select the Start and End dates for the 3 periods. 
7 Click OK to confirm your additional settings.

You can now make your report request.
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Moving Average for a list 

This report displays the moving average for Constituents and the constituents of a 
Local List. 

You can:
� Select a datatype or expression 

� Select the moving average period

� Select a second display date

To specify additional settings for the Moving Average for a list Summary:

1 Select an appropriate data category and series.
2 Select the Summary tab.
3 Select Moving Average for a list from the selection list.
4 Click the Settings button.
5 Select either the Use Datatype as the Expression option,

Use Navigator to select a datatype.OR
the Use an expression option.

6 Select the moving average period from the Moving Average Period: drop down 
box

7 Select the second display date from the Second display Date boxes.
8 Click OK to confirm your additional settings.

You can now make your report request.
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Performance Ranked Report

The Performance Ranked Report ranks the constituents of a selected list in 
descending order of % price change, over a selected time period. Reported 
information, for each ranked series, includes price values as at the start and end of the 
time period plus actual and adjusted % price changes.

Settings enables you to choose one of three additional display options:
� Display the % price change relative to a specific index that you select. This data is 

displayed under an additional column labelled %Chg Rel.

You can search through a complete list of Datastream and industry standard 
indices to select the relative index. Navigator is located on the Index Selection 
dialog to help you find your series.

� Display the % price change relative to a default index type that you select. This 
data, again, is displayed under an additional column labelled %Chg Rel.

This option lets you to leave the decision on what relative index to use to 
Datastream. You choose the type (market or sector) and level of default indices 
(e.g. level 4), and Datastream chooses the actual relative index based upon the 
list you select. 

� Turn off the relative/default index display.

This option enables you to switch off the additional (optional) column % Chg Rel.

To specify additional settings:

1 Select the Constituents or Local Lists data category and an appropriate list.
2 Select the Summary tab.
3 Select Performance Ranked.
4 Click the Settings button. 

The Index Selection screen is displayed.
5 Choose an index:

• For a specific index
- ensure the Ignore Index check box is unchecked
- click the Relative Index tab
- use Navigator to find your index
- select the required indices
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• For a default index
- ensure the Ignore Index check box is unchecked
- click the Default Index tab
- click either the market or sector options
- select the required default market or sector index type

6 To turn off the relative index column
- click the Ignore Index check box

7 Click the Sort Order tab.
8 Select the Primary and Secondary sort orders. 
9 Click OK to save your report settings

You can now issue your report request with your additional settings.
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Performance ranked over 3 months

This report displays, in percentage terms, the price performance of series in a selected 
constituent list over the last three months. The displayed percentage is the actual 
percentage change between the series price three months ago and today’s price. Both 
prices are displayed in the currency in which they are held. An additional percentage 
change value is converted to the local currency, if the local currency is different from 
the series reported.

� The settings facility gives you two options for selecting Y. 
• Select default index

This option allows you to leave the decision on what relative index to use to 
Datastream. You choose the type (market or sector) and level of default 
indices (e.g. level 4), and Datastream chooses the actual relative index based 
upon the series you select.

• Select a specific relative index
You can search through a complete list of Datastream and industry standard 
indices to select the relative index. Navigator is located on the settings screen 
to help you find your indices.

� Select primary and secondary sort orders

To specify additional settings:

1 Select an appropriate data category and series.
2 Select the Summary tab.
3 Select Performance ranked over 3 months.
4 Click the Settings button.
5 Choose one of the following index options:

• For an individual index
- click the Relative Index tab
- use Navigator to find your series

• For a default index
- click the Default Index tab
- click either the market or sectoroptions
- select the required default market or sector index type

6 Click OK to save your chart settings.

You can now make your chart request.
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Regression and Correlation for a list

This report displays the regression and correlation for Constituents and the 
constituents of a Local List. 

You can:
� Select a base item, using Filter and Find: to speed your search

� Select the frequency. For example, they can represent daily, weekly, monthly, 
quarterly, or yearly prices

� Select the sort order
� Determine the type of plot scale, linear scale or logarithmic scale

To specify additional settings for the Regression and Correlation for a list 
Summary:

1 Select an appropriate data category and series.
2 Select the Summary tab.
3 Select Regression and Correlation for a list from the selection list.
4 Click the Settings button.
5 Select the Base Item. Select the data category and the base item from the list 

displayed.
6 Select a plotting frequency by dragging the slider to the required frequency.
7 Select the sort order from the Sort Order drop down box.
8 Click either the Linear or Logarithmic option buttons.
9 For lists exceeding 100 items, select the start and end at list item numbers.
10 Click OK to confirm your additional settings.

You can now make your summary request.
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Scatter Chart for a list

This displays a scatter chart for Constituents and the constituents of a Local List. 

You can:
� Type a chart title and legend

� Display a best fit line

� Determine the type of plot scale, linear scale or logarithmic scale
� Select expressions from the Expression Picker for the X and Y axis

� Select the X and Y axis ranges and intersection values

To specify additional settings for the Scatter Chart for a list:

1 Select an appropriate data category and series.
2 Select the Summary tab.
3 Select Scatter Chart for a list from the selection list.
4 Click the Settings button.
5 Type the chart title in the Chart Title field.
6 Type the legend in the Legend field.
7 Click the Best Fit Line Required box if you require one.
8 Click either the Linear or Logarithmic option buttons.
9 Select the X and Y axis ranges and intersection values. 
10 Click OK to confirm your additional settings.

You can now make your summary request.
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Scatter Chart for a list (data only)

This displays a scatter chart for Constituents and the constituents of a Local List. 

You can:
� Type a chart title and legend

� Display a best fit line

� Determine the type of plot scale, linear scale or logarithmic scale
� Select expressions from the Expression Picker for the X and Y axis

� Select the X and Y axis ranges and intersection values

To specify additional settings for the Scatter Chart for a list:

1 Select an appropriate data category and series.
2 Select the Summary tab.
3 Select Scatter Chart for a list from the selection list.
4 Click the Settings button.
5 Type the chart title in the Chart Title field.
6 Type the legend in the Legend field.
7 Click the Best Fit Line Required box if you require one.
8 Click either the Linear or Logarithmic option buttons.
9 Select the X and Y axis ranges and intersection values. 
10 Click OK to confirm your additional settings.

You can now make your summary request.
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Static Data

Static data requests download values for a selected series at a particular point in time. 
Settings lets you to define the data you download from Datastream and determine 
how it is labelled. Using Settings, you can select up to 9 datatypes. 

Note:
The datatype NAME is added as the first datatype for each request. NAME provides the title of 
the data series.

The type of datatype you can select is dependent upon the data category chosen. For 
equities, for example, you can select from Datastream, I/B/E/S and MSCI datatypes, 
and Worldscope, and Datastream Company accounts data items.

The Expression Picker and Expression Builder facilities are located on this dialog, if 
you want to create or use an existing expression as part of the static data request. See 
About Expressions and Functions, page 46.

To specify additional settings for Static Data:

1 Select an appropriate Data category and Series.
2 Select either the Data or Comparison tab.
3 Select Static Data from the selection list.
4 Click the Settings button.
5 Use Navigator to select your datatypes.
6 Select a datatype from the displayed list, select a currency, and click the right 

arrow button to add each datatype to your list. Select up to 9 datatypes.
Note: The currency field is disabled if the datatype is not currency convertible.

7 Click the Remember Datatypes check box to store your datatype selections for 
use with Flexible Report requests. As the Flexible Report uses up to five 
datatypes, only the first five datatypes selected for Static Data requests are 
stored.

8 Click the Display Options you want: Titles,Column Headings, Row Headings, 
and Currency.

9 If your static data request is for a Local List, click the Retain List check box. The 
list of datatypes for your request will be retained on the host system so you can 
embed the data request in Excel.

10 Click OK to confirm your additional settings.
You can now issue your data request with your additional settings.
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Yield Curve Chart settings

The Yield Curve Chart has been available, under the Charts tab, since the release of 
Datastream Advance 1.0. However, its use has been limited to displaying yield curves 
on Datastream compiled lists of bonds. These lists are of Government bonds for all 
major economies selected from the Economic reports/charts data category tab.

The Yield Curve Chart is still available for use with Economic reports/charts, 
however with Datastream Advance 4.0, the list selection and yield calculation facilities 
have been extended to bring it in line with the DSWindows equivalent - 401N. This 
chart is selected under the Summary tab and you can choose your own bond list 
under either the Constituents or Local Lists tabs. Settings lets you to make the 
following changes under their respective tabs:

First & Second Curve

� Set the power of curve (from 0 to 5), and short-end stabilisation (using interest 
rates) for the first curve. The bond list for this curve is selected on the main 
Request screen and is displayed in the field Your Current Selection when you 
click Settings.

� Set the power of curve (from 0 to 5), and short-end stabilisation (using interest 
rates) for an optional second curve. The second curve is selected by clicking the 
Second Curve check box and selecting a bond list using the series display grid 
and filter facilities.

General Settings

� Choose the basis on which the redemption yield used to plot the curve(s) is to be 
calculated; for example, using the maturity date, average life, equivalent life, etc.

� Choose the frequency of yields used in the yield calculation; for example, annual 
or semi-annual compounding of interest.

� Display scatter for first or second curve.
� Select two separate dates for one yield curve, or select one date if two yields 

curves are specified on the First & Second Curve screen.

Axis Settings

� Select what type of yield/life data is displayed on the Y and X axes. Typically this 
would be Redemption Yield for Y axis and Life for X axis, however you can select 
Duration or Modified duration for the X axis and Interest yield for the Y axis.

� Eliminate extreme values from the line plot for both curves by specifying Above 
and Below values for the Y and X axes, or allow Datastream to provide default 
values.

� Transform the X co-ordinate data to prevent any extreme values having an 
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unwarranted effect on the curves by using the X Axis Decimal Log Transform 
facility, or allow Datastream to provide default values.

� Change the Y and X axes scale range of the displayed chart and their intersection 
point, or allow Datastream to provide default ranges.

See the Datastream Graphics User Guide for a full description of all these settings.

Example:

In the following example, two bond yield curves are plotted against an Irish 
Government Bond index using both power 5 and power 3curves with scatter.

1 Assuming you have downloaded the Irish Government Bond index (IRGVT) 
constituents using the Download a Constituent List option on the Local Lists 
wizard, select the Irish Government Bond index under the Local Lists tab.

2 Select the Yield Curve Chart under the Summary tab.
3 Click Settings to display the Yield Curve Chart Settings dialog.
4 On the First & Second Curve tab, select the Power of Curve required for the 

first curve; for example 3, by using the spin buttons.
On this screen, you can set a short end stabilisation by clicking the Interest 
Rates... button and selecting an interest rate from the displayed picklist. If you 
change your mind, click Clear to remove the selected short end stabilisation.

5 To produce a second curve on the same bond list but using a different power, 
click the Second Curve check box and ensure that the Power of Curve 2 option 
is set to 5.

6 On the General Settings tab, type the required chart title (for example, Irish 
Government Bond List - Yield Curve) in the Title field.

7 Set the required Yield Basis, Yield Frequency and Display Scatter options by 
selecting from their respective picklists. Selecting Datastream Default for Yield 
Basis will select Average Life for Eurobonds with a sinking fund, Equivalent life for 
non-Eurobonds with sinking fund and final date for all other issues.

8 Click the Calculation Date (First Curve) button to display the Configure Dates 
dialog to select the bond yield curve calculation date. If you have opted to display 
a second curve on the First & Second Curve tab (as in this example), you can 
only use one date. If you are using just one curve, then you can display it on two 
different dates using both Calculation Date buttons.

9 On the Axis Settings tab, select the required X and Y Axis options, the default 
values for these include Life plotted on the X axis and Redemption Yield plotted 
on the Y axis. Use the dropdown lists to select the required axis options.

10 Set the required scale ranges (for example Above 0 and Below 100) for the X 
and Y Axis Ranges, if required. Alternatively, use the Datastream Default.
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11 Enter values in the Display Modification section the specify the numerical range of 
the axes and the point at which they should intersect, if required. Alternatively, 
use the Datastream Default.

12 Click OK to complete your Yield Curve Chart settings.
13 Click Run Now to issue the Yield Curve Chart request.
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Comparison settings

Correlation Chart for 2 items

This displays a correlation analysis for two or more series over time.
You can:

� Type a Chart Title

� Determine the frequency of the price bars. For example, they can represent daily, 
weekly, monthly, quarterly, or yearly prices.

� Determine the type of plot scale, linear scale or logarithmic scale

See the Advance Reference guide, Advance Tools Catalogue, page 19, for details on 
the display period, datatypes and currency adjustments you can make for each data 
category.

These settings are made on the Correlation Chart for 2 items settings dialog.

To specify additional settings for the Correlation Chart for 2 items:

1 Select an appropriate data category and series.
2 Select the Comparisons tab.
3 Select Correlation Chart for 2 items from the selection list.
4 Click the Settings button.
5 Type a title in the Chart Title field.
6 Select a rebase option from the Rebase Options drop down box.
7 Click either the Linear or Logarithmic option buttons. 
8 Select a plotting frequency by dragging the slider to the required frequency.
9 Click OK to confirm your additional settings.

You can now make your chart request.
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Datastream 401X Format

This tool is for DSWindows users, who want to use their existing 401X formats within 
Advance. Once you have run your 401X formats in Advance, the formats can be saved 
in a Project as Advance requests for regular use and refreshing. Any 401X format can 
be used; this includes formats with up to four symbolic variables. The display attributes 
(for example X and Y axis scale settings) of the 401X formats are maintained when 
you issue the request. You can override the display period or use the format’s display 
period.

� You need to know the 401X format code, for example Z34G, and the number of 
symbolic variables (X, Y, etc.) in the format. (For formats with no symbolic 
variables, the Number of Series in the setting screen should be set to 0).

� For a format that has two symbolic variables, (e.g., Z34G has a stock and an 
index) type 2 in the Number of Series field.

To specify settings for the Datastream 401X Format comparison:

1 Select the Comparison tab.
2 Select Datastream 401X Format from the list.
3 Click the Settings button.
4 Type the 401X format code in the Format Code field.
5 Use the up and down buttons to select the number of series the format expects 

(up to four).
6 Click the Use dates from format check box to use the format’s dates, if required.
7 Click OK on the Settings dialog.
8 Select a series, if the format has symbolic variables. 
9 Click the Add button to add the number of series to the Comparison Request 

List.
10 Repeat steps 6 and 7 for the number of series that are required in the 401X 

format. 
11 Adjust the display period, if required. 
12 Click Run Now to issue your 401X Format comparison request.
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Performance range and average for 8 series

You can:

� Select a datatype or expression 
� Select a second display date

To specify additional settings for the Performance Range & Average for 8 series:

1 Select an appropriate data category and series.
2 Select the Report tab.
3 Select Performance Range & Average for 8 series from the selection list.
4 Click the Settings button.
5 Select either the Use Datatype as the Expression option,

Select the type of Datatype from the drop down box and select the datatype from 
the list displayed. You can use Find: to speed up your search.
OR
the Use an expression option

6 Select a second display date from the Second display Date boxes.
7 Click OK to confirm your additional settings.

You can now make your report request.
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Recent Values & Ranges for 3 series

This chart shows the latest value, high, low, and annual high/low/averages for up to 
three series.

You can:
� Select a number of years, up to the maximum time limit of the stored data, for 

ranges.

To specify additional settings for the Recent Values and Ranges for 3 series:

1 Select an appropriate data category and series.
2 Select the Comparisons tab.
3 Select Recent Values and Ranges for 3 series from the selection list.
4 Click the Settings button.
5 Select the number of years for ranges.
6 Click OK to confirm your additional settings.

You can now make your chart request.
Datastream Advance version 4.0, Issue 1 176



Advance User Guide
Regression & Correlation for 10 series

This report displays the regression and correlation for 10 series. 

You can:
� Select a datatype or expression 

� Select a second display date

To specify additional settings for the Regression & Correlation for 10 series:

1 Select an appropriate data category and series.
2 Select the Comparisons tab.
3 Select Regression & Correlation for 10 series from the selection list.
4 Click the Settings button.
5 Select either the Use Datatype as the Expression option,

Use Navigator to select your datatypes
OR
the Use an expression option

6 Select a second display date from the Second display Date boxes.
7 Click OK to confirm your additional settings.

You can now make your report request.
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Scatter Chart for 2 Items

This displays a scatter chart for a constituent list or two series over a period.

You can:
� Type a chart title and legend

� Display a best fit line

� Determine the type of plot scale, linear scale or logarithmic scale
� Select expressions from the Expression Picker for the X and Y axis

� Select the X and Y axis ranges and intersection values

To specify additional settings for the Scatter Chart for 2 items:

1 Select an appropriate data category and series.
2 Select the Comparisons tab.
3 Select Scatter Chart for 2 items from the selection list.
4 Click the Settings button.
5 Type the chart title in the Chart Title field.
6 Type the legend in the Legend field.
7 Click the Best Fit Line Required box if you require one.
8 Click either the Linear or Logarithmic option buttons.
9 Select the X and Y axis ranges and intersection values. 
10 Click OK to confirm your additional settings.

You can now make your summary request.
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Time Series Data

The settings available for time series data requests enable you to specify the 
frequency of reported data for the time period selected. The default is daily, however 
you can change this to Weekly, Monthly, Quarterly and Yearly. There is no restriction 
on the amount of data you can display except for a limit of 16,384 rows in the display 
area. So for example, you could display over 10 years worth of daily data.

In addition to the settings for data frequency, you can also select a number of display 
options which include:
� Titles - general headings for row and column titles, for example CODE for series 

and datatype mnemonics.

� Column headings - the datatype mnemonic at the top of each column

� Row headings - the series mnemonic at the head of each row for each series 
selected

� Currency - display an additional column with the title CURRENCY and with the 
traded currency for each selected series.

The selections are made on the Time Series Data settings screen:

The Lin/Log settings are not available for time series data requests. 

To use the Time Series Data settings:

1 Select an appropriate data category and series.
2 Select the Data tab.
3 Select Time Series Data from the selection list.
4 Click the Settings button. The Time Series Data settings dialog is displayed.
5 Choose the data Frequency by dragging the slider to select the required 

frequency.
6 Select the Display Options by clicking the required check boxes.
7 Click OK.
Datastream Advance version 4.0, Issue 1 179



Advance User Guide
Values over time for 12 Economics

You can:

� Select monthly, quarterly, or annual frequency

� Select the start and end dates

To specify additional settings for the Values over time for 12 Economics:

1 Select an appropriate data category and series.
2 Select the Comparisons tab.
3 Select Values over time for 12 Economics from the selection list.
4 Click the Settings button.
5 Select a frequency option.
6 Select the Start and End periods.
7 Click OK to confirm your additional settings.

You can now make your chart request.
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